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Excel 2010 For many people, Microsoft Office Excel 2010 is one of the programs you grow into. If their tasks do not require detailed knowledge of the spreadsheets from the outset, their earliest experience with Office Excel 2010 might have been to create simple financial documents –
perhaps in response to a manager's request, a need in their own company, or a question from a financial advisor. Over the years, Office Excel has evolved from a basic spreadsheet tool to an important business application that enables information workers to create, analyze, consolidate,
report reports. And share important information that affects the entire business lifecycle. This is not your grandmother's calculator! Office Excel 2010 faces the same challenge as Microsoft* Office Word 2010: it provides powerful, sophisticated tools in an accessible way that enables both
experts and beginners to easily find what they need and achieve professional, accurate, and insightful results. The most important changes in Office Excel 2010 provide exciting ways to create, simplify and extend financial document sharing—spreadsheets, workbooks, reports, and more. In
particular, the additions and enhancements in Office Excel 2010 help users create better spreadsheets faster, better understand, visualize, and share important information, and make data analysis easier and more effective, resulting in better better for decisions that affect the final result.
This chapter introduces some of these important changes. The design of Office Excel 2010 The new results-oriented look of Office Excel 2010 brings to your workspace the tools you need and only the tools you need to complete what you want to create, analyze, or illustrate in your
worksheet. In line with other major Microsoft Office system applications, the user interface is designed to help you be more productive by offering a set of command tabs, command sets, and context commands to specific objects in your worksheet. Here is a list of the command tabs you can
find in Office Excel 2010: The Home tab contains the commands you need to work with the clipboard. Selecting and changing fonts; control the alignment of the cell contents; Select number formats; Select The cell style and format; and edit, sort and search your data. The Insert tab contains
the commands for the objects you add to your worksheets. Z.B. Tables, charts, illustrations, links, and various types of text elements, such as .B column or row labels. The Page Layout tab provides everything related to setting up the worksheet, including selecting themes, selecting page
setup options, controlling the scaling of individual objects, selecting worksheet options, and arranging items on the sheet. The Formulas tab contains the Function Wizard, the Function Library, the commands you need to create and work with named cells, formula monitoring commands, and
calculation options. The Data tab provides commands for retrieving external data; manage connections to external links; sort and filter your data; Remove duplicates, validate and consolidate your data, and group and ungroup cells. The Review tab contains what you need to prove,
comment, and share the sheet. On the View tab, you can find commands for selecting different workbook views. Hide and redisplay worksheet items (grid lines, ruler, formula bar, and more), zoom in or collapse the display, and work with the worksheet window. Tip: For more information
about the new items in the Microsoft Office system user interface—including the new command sets, context tools, live previews, galleries, and more—see Chapter 2 A New Look. Page layout: A new view for better printing of catching up with the margins and including everything you want
on the site can be a challenge (and time-consuming!) for both new and experienced Office Excel users. Office Excel 2010 reintroduces a new view called Page Layout that lets you see how your worksheet develops as you work. View the worksheet in the print layout view by clicking the
View tab and selecting The Page Layout View. The page layout view makes printing easier by removing puzzle guessing. Rulers along the tip On the left side of the workspace, you can schedule specific content areas on the page. Because everything in the page layout view is fully editable,
you can make data changes, select new matting options, and save and print in this view. You can also view multiple pages in the page layout view by reducing the size of the pages using the Zoom control. Tip: Make changes that relate to the appearance of the overall document, such as.B
adjusting margins, changing alignment, or filtering data while you are working in print layout view. This gives you the best large picture of how the changes in printing affect your worksheet. The print layout view is also available in the view controls in the lower-right corner of the Office Excel
2010 window. The three views that appear in the control (to the left of the zoom control) are Normal New. Page layout view and page break preview. Tip: The Custom Views feature in Office Excel 2010 is now available on the Page Layout tab of the user interface. Set the display features as
you want to click custom views, and then click Add to create a view that you can apply to other worksheets. More space, more speed, more choice Some of the changes in Office Excel 2010 will be most important for power users who create, update, modify, and report on mega worksheets
that require maximum computing power and speed. The following is an overview of some of the changes that affect how Office Excel 2010 manages and supports large, complex worksheets. When you select the row and column boundaries of Office Excel 2003. You'll be glad to know that
the Office Excel 2010 worksheet has been greatly enlarged, according to David Gainer. Group Program Manager for Microsoft Office Excel. In particular, the Excel 12 grid will be 1,048,576 rows through 16,384 columns. That's 1,500 percent more rows and 6.30 percent more columns than
in Excel 2003. And for those of you who are curious, columns now land on XFD instead of IV.-1 And even on huge, formula-intensive worksheets you'll experience faster calculations, as Office Excel 2010 now supports dual processors and multithreaded chipsets that allow Office Excel 2010
to fully exploit your system's computing power and dramatically reduce your wait time. Another speed booster: Memory management in Office Excel 2010 has been created by 1 GB 2 GB increased. Give you more space to work with complex, sophisticated spreadsheets that previously
mixed your system resources. In addition, Office Excel 2010 moves the bar to some of the limits in the earlier version. For example, you can now set unlimited formatting in the same workbook (this was used to cap 4,000 format types). Office Excel 2010's color palette has grown to support
the full 16 million colors, and now you can create as many cell references to a single cell as yours Memory is allowed (this was previously limited to 8,000 references per cell). Create better tables, faster Most professionally created worksheets today – when it is shared with an audience a-
house – contain a little design. The titles are formatted to stand out; Or shades can be used to draw attention to specific areas of interest. Worksheets, when included in financial reports, business plans, or presentations, often get the same look and feel as the surrounding material, making
the font, color, and arrangement of the information important. Office Excel 2010 makes it easy to create better-looking documents by providing a set of easy-to-use formatting options. When you work in print layout view, you can see what these design changes look like when you print them.
Easier access to new templates When you start a new worksheet in Office Excel 2010 by selecting New from the File menu, the New Workbook window opens, which immediately provides you with a list of template categories to choose from. This makes it easier to connect to Microsoft
Office Online (which Office Excel 2010 does automatically when you select a template type) and to find the template categories that you might want to try. Click the template category you want to view (e.B. Business), and if the category contains subcategories, click the category you want
(e.B accounting). Office Excel 2010 connects to Microsoft Office Online and displays a collection of templates that are available in this category. The selected template appears in a preview window on the right side of the window. If this is the template you want, click Download to download it
to your system. Three things to try Out Mark Dodge and Craig Stinson authors of Microsoft Office Excel 2010 Inside Out, recommend these as their favorite new features: 1. Use page layout view to see how your worksheet is distributed between pages to quickly switch between portrait and
landscape, and type headers and footlines directly on the worksheet. 2. Use table styles in conjunction with themes to give your workbooks a consistent, professional look. 3. Use the new conditional formatting features to highlight dates that meet dynamic conditions, such as.B yesterday,
today, last week, next week, or next month. Try out the way you find cell styles and designs in Office Excel 2010, and represents a huge improvement over the text-based options available in Office Excel 2003 that are buried in the menus. Now you can select an area of your worksheet.
Click Themes in the Page Layout tab of the user interface; and try a gallery of design styles that change the color, font, and spacing of the selected cells. Tip: As you can see, selecting another topic changes a collection of format elements. Several multiple are included in each theme: the
colors that the fonts use, and the effects. The three tools to the right of the Designs command allow you to set each of these items separately if you prefer to set the format of a cell that used to be something that required thought and effort. Now you can apply predefined formats to cells and
ranges by simply clicking the Cell Styles command and selecting the format from the catalog that appears. You can find the Cell Styles command on the Home tab; Simply click the command to view an available format and select it. Tip: You can create formats for your own cell styles and
add them to the gallery. First, apply the format you want to a specific cell, click Ceil Styles on the Sheet Command tab, and select New Cell Style in the Cell Styles catalog. Check the information in the Style dialog box, and click Format if you need to make changes, type a name for the style
in the Style Name box, and then click OK to save the style. The new style you created appears at the top of the gallery in the Custom category. Click-and-type headers and footers If you've ever had a problem trying to correctly print headers and footers on your worksheets in the past, you'll
appreciate the simplified way you add and edit headers and footers in your Office Excel 2010 worksheets. Now you can simply click on the Insert Command tab and click Header &amp; Footer in the text command set. The worksheet appears in the page layout view, and the user interface
changes to provide a collection of header and footer tools. A header box opens on the worksheet. You can simply click and enter your header and use the displayed items to add items you need. e.B. page number, date, time, and worksheet name. Tip: The Auto Header and Auto Footer
commands on the left side of the header and footer tools give you a collection of pre-made headers and footers that you can apply to your worksheet. Simply click on the command and thick the selection to automatically add it to your worksheet. The benefits of Microsoft Office Open XML
The applications in the Microsoft Office system now use the Microsoft Office Open XML format as the default file format. Open XML provides users with several key benefits that directly relate to issues that are important to Office Excel 2010 users: % Open XML allows you to store huge
worksheet files by using only one the space required for the previous format. Open XML stores data regardless of format or schema that is used to display the data in a specific way. This means that the content can be preserved and used in an almost unlimited way, regardless of its
particular form. The information that you create and share in your Office Excel 2010 worksheet, chart, or report can later be integrated into other worksheets or documents that you create, saving you time and reducing the margin of error in the important data. Important chart diagrams give
you the ability to communicate visually and quickly—the numeric story that your worksheet tells. Charts help others understand how to interpret your data so that you can view trends and comparisons quickly and colorfully. Office Excel 2010 includes a variety of chart enhancements with
galleries of pre-built formats that you can apply instantly, great new 3D options, and a full set of context tools to communicate your message in the right way. Start the process by selecting the range of data you want to draw. Then click the Insert tab and select the type of chart you want to



create. The chart appears on your worksheet, and the Chart Tools context tab provides three complete options for customizing your charts: On the Design tab, you can select the chart type, data source, and arrangement. Quick Styles and the Move Chart command. On the Layout tab in
Chan Tools, you can enter chart properties, select Office shapes, add or edit chart items, and make decisions related to 3D charts. The Format lab gives you the ability to select different chart elements, add styles to the chart shape, including 3D edges, shadows, bevel, and more. New
Office shapes and WordArt Office shapes—the lines, rectangles, block arrows, and more buried in the New Drawing Toolbar have their own place on the Insert toolbar. To view the advanced collection of shapes, click the Shapes tools to find more choices and new categories, including new
equation shapes. WordArt has also been improved and made more accessible, which is now housed in the text command set of the Insert menu. When you select the WordArt command, a gallery of styles appears. Click the item you want and the WordArt item will be placed on your
worksheet. Click Item to tap it through your own text: Office Excel 2010 includes the Smart Art option for these limes if you want to add a sophisticated chart to your worksheet. To create Smart Art graphics, select the Insert tab. Click Smart Art In the Illustrations command tab. Select the
type of chart you want to create, choose the style you prefer, and click OK. Conditional Formatting and Data VisualizationConditional Formatting is a great feature that allows you to apply certain formatting to cells according to the value of a or the value of a formula. This feature makes it
easy to point out specific values or trends in your worksheet so that others can see what they want to see. Some conditional formatting was available in Office Excel 2003, but in Office Excel 2010 it's easier to find and use, and you can set up conditional formatting without writing formulas.
First, select the range of cells to which you want to apply conditional formatting. Then, on the Sheet tab, click Conditional Formatting. The menu menu appears provides two different rule sets—highlighting cell rules and top/bottom rules—that you can apply to your data by simply selecting
the rule you want to apply. For example, to quickly find the top 15 percent of the values in your selected range, select Top/Bottom Rules and click Top N in the window that appears, increase the percentage to 15, and select the condition you want to apply (the default is red fill with dark red
text). The change previews the worksheet as soon as you make the selection. Click OK to save the change in addition to these predefined rules. Office Excel 2010 includes new data visualizations that help you understand and illustrate trends and comparisons in your data, here are the
three new data visualizations: Data bars show you immediately, in the form of value bars, how the values of selected cells are compared with each other and with the whole. Color scales apply color schemes that you select for a specific range of values so that individual cells appear in a
specific color based on their value. Symbol sets provide you with a set of individual characters that you can apply within the cell to display trends in different ways. Create conditional formatting rules You can design your own rules to customize the visualizations to your own worksheets.
When you select a new rule from the Conditional Formatting menu, the New Format Rule rule dialog box opens. (If you previously applied a Conditional Formatting Rule to the selected range, the settings for this rule sheet are displayed by default.) Select a rule type (e.B. Format Only cells
that are included) and edit the rule description so that you see the formal format that you want to display when you apply the new rule. Click OK to save the new rule and apply it to the selected cells. Services Excel Services is a new feature in Office Excel 2010 that allows you to save your
workbook to a server running Microsoft Office SharePoint Server 2010 (and which also supports Office Excel Web Access). Here are some of the biggest benefits of using Office Excel 2010 with Excel Services: Sharing and Managing Collaborative Worksheets. View only the worksheet
ranges for which users have permissions to view. Hide sensitive data, formulas, and macros To create, sort, filter, and modify PivotTable views using any web browser. To set permissions on the worksheet to change the worksheets or ranges you want to make available to the specified
users, open the File menu, point to Save As, and click Excel Services. The Save As dialog box provides a button for Excel Services options that lets you control which sheets are visible in the user's browser. After you have made your selection and click OK. Type the name of the shared
folder in the Save box in and click Save. The file is stored on Office SharePoint Server 2010, and your team members can access the worksheets from the Web. Fast fast through Office SharePoint Server 2010 and Office Excel 2010 You can store sensitive or critical spreadsheets in Office
SharePoint Server 2010 and specify permissions for which items (specific worksheets, tables, charts, ranges, and so on) are available to other team members. Office SharePoint Server 2010 includes Report Center, which allows users to create and work with trusted data connections so
that they can securely connect to external data sources. Use Office SharePoint Server 2010 too centrally to store critical spreadsheets too centrally, to control the distribution of multiple versions, and to ensure that business members and partners are working with the latest files. Pivot
Tables Views – More support, better insights If part of your work is to make large amounts of data meaningful and display it in a format that is understandable to both others and others, it makes it easier for Office Excel 2010 to make PivotTables easier to understand and use. Sometimes the
simple things make a big difference - like adding an undo function for most operations, using the known plus and minus indicators to drill down, and sorting and filtering data. More PivotTable support Start the process of creating a PivotTable by selecting the range of data you want to use in
your report. then click PivotTable on the Insert tab. The Create PivotTable dialog box prompts you to confirm the selected range and choose whether to create the PivotTable report on a new worksheet or on the existing worksheet. Make your choice and click OK. The PivotTable Hero List
appears in a panel on the right side of the workspace, and the PivotTable Tools context tab appears above the user interface. On the Design tab, you can select the layout of pivottable options, add Quick Style features such as column and row headings, and select a design from the
PivotTable Quick Style Gallery. Improved Pivot Charts If you are satisfied with the PivotTable you created, you can turn these numbers into a visual formalein by creating a PivotChart to illustrate your data. The advanced features for pivot charts in parallel with those found in the chart
improvements in Office Excel 2010; When you create a pivot chart, you have both the chart tools and the pivot chart tools at your disposal, so you can use a wide range of options to analyze, view, sort, edit, and save your Offer. The building blocks: values, cell references, and operators.
The building blocks of Excel formulas are values, cell references, and operators. A value can take the form of a number (20, 100, .015), text (The Fuqua School of Business, Duke Basketball), or a date (April 1, 2001, April 1, 2001). A cell reference identifies a single cell or range of cells on a
worksheet and tells Excel where to look for the values or data you want to use in a formula. For references, you can use data data in different parts of a worksheet in a single formula, or use the value from a cell in multiple formulas. You can also reference cells in other sheets in the same
workbook, other workbooks, and data in other programs. References to cells in other workbooks are called external references. References to data in other programs are called remote references. Excel has two cell reference styles: the A1 style and the R1C1 reference style. By default,
Excel uses the A1 reference style. This style refers to columns with letters (A to IV, for a total of 256 columns) and rows with numbers (1 to 65,536). These letters and numbers are called row and column headings. To refer to a cell, type the column letter followed by the row number. For
example, D50 refers to the cell at the intersection of column D and row 50. To reference a range of cells, type the reference for the cell in the upper-left corner of the range, a colon (and then the reference to the cell in the lower-right corner of the range). Examples of A1 references: To refer
to Using the range of cells in column A and row s 10-20 A10:A20 The range of cells in columns A-E and rows 1-20 A1:E20 All cells in row 5 5:5 All cells in rows 5 through 10 5:10 All cells in column A A: A All cells in columns B to H B: H 2 To experiment with reference types, that you may
not be familiar with, click the F5 key to open Excel's Go To dialog box, and type a reference in the Reference box to see the cell/range selection in your spreadsheet. The R1C1 reference style numbers both the rows and columns in a worksheet. The R1C1 style is especially useful for
calculating row and column positions in macros. In R1C1 style, Excel specifies the position of a cell with an R followed by a row number and a C followed by a column number. Turn the R1C1 reference style on or off by selecting Tools, Options, and the General tab. 3 The Formula operators
of Excel specify the calculation type for the elements of a formula. Excel has four different types of calculation operators: arithmetic, comparison, text, and reference. Calculation with date and time values Excel stores dates as sequential numbers called serial values. Excel stores times as
decimal fractions because time is considered part of a day. Because Excel treats dates and times as values, they can be added, subtracted, and included in other calculations. For example, in order to reduce the difference between two dates, subtract a date from the other date. Display a
date as a serial value and a time as a decimal fraction by changing the format of the cell that contains the date or time in the General (Number) format. Example: Date number 4/10/01 369913:15 0.1354 For a date calculation, refer in the formula either to cells that contain dates or -- to
include current dates the formula— surround it with double quotation marks. For example, this formula: =4/10/01 - 3/10/01 gives the value 31. Excel supports two date systems: the date systems 1900 and 1904. The default date system for Excel is 1900. If you need the 1904 date system,
select Tools, Options, select the Calculation tab, and switch to the 1904 Date System check box. The following table shows the first date and date for each date system and the serial value of each date. 1900 1 January 1, 1900 (serial value 1) 31 December 9999 (serial value 2958465) 1904
2 January 1904 (serial value 1) 31 December 9999 (serial value 2957003) Use the FUNCTION DATE to manipulate part of a date within a formula. Use the TIME function to edit part of a time (e..B hour, or minute— within a formula. For more options, see the Date &amp; Time category of
the built-in Excel features. By default, dates entered in a workbook are formatted to display two-digit years. Use Windows Control Panel to change the default date format if you want to display four-digit years instead of two-digit years. Names and ranges used in formulas use names in Excel
instead of cell references in formulas. Naming key cells can make it easier to read worksheet formulas. In the following example, the formula bar displays the formula in cell E3 as =TotalSales*TaxRate. Without cell names, the formula would appear as less comprehensible =D3*B1. If you
assign names to cells after you use these cells in calculations, Excel does not automatically replace cell references with the new cell names in the calculations. However, you can override this default setting and use new names after formula creation with the Insert, Name, And Apply
command. Quickly name a cell or range by selecting it and typing the name in the name field to the left of the edit bar. The name field displays the current cell or range reference, or the current cell or range name, if assigned. Name a cell or range to get there quickly with the F5 Go To key.
When you press F5, the Go to dialog opens. 14 range names for an Excel list (such as the simple one below) can be used to simplify references and calculations. In this example, select the list (the B3:C7 area in the figure below) and use Insert, Name, Create to open excels Create Names
dialog box. Excel guesses where the probable names are in relation to the data. In this case, the in C4:C7, and the names come from the top row and the left column. If names are set, you can use a short reference to reference the numeric cells. Cell C4 can also be called January A
because it is at the intersection of these row and column names. Similarly, cell C5 can also be referred to as January B. Cell E5 contains the formula =January A and displays the value 10. Cell E6 contains the formula = = A + January B and displays the value 25. There is another way to
name a range whose values you want to use in a calculation: Using the special Label Ranges dialog. In this example, imagine a list of values like the one on the right, with the year99 label at the top of the column. Select the area (including the caption) and select Insert, Name, Label to open
the Label Areas dialog box. Excel fills in the label area. Specify that you are using column labels and click OK. Use this method to specify ranges that contain column and row labels on your worksheet. Year99 10 30 50 50 15 You can now use the label range name in calculations. For
example, this formula: =SUM(year99) returns a value of 140. The formula =SUM (year99, 100) returns the value 240. As a faster alternative to using the Insert, Name, Label command, you can select a range (without header) and use the Name field to assign a range name. Then use this
range name in calculations, as above. A named cell (or range) is treated as an absolute reference in a formula. If you want to assign a name to a cell or range and then change it, you can do so. But Excel is not an easy way to do it. The only way to change a range name is to use Insert,
Name, Define, Add the new name, and then delete the old name. Understand Relative, Absolute, and Mixed Addressing You often want to use the same formula in one or more places on a worksheet. The most efficient way is to create the formula once and then copy it to the other locations
where you need it. When you copy a formula, you need to understand the relative and absolute addressing of Excel. When you copy a formula, Excel uses relative addressing as the default. That is, when you copy the formula to a new location, Excel adjusts the cell references in the copied
formula relative to its new position. In the figure at the bottom left, the formula in cell D4 is used to calculate the total sales in January and February for department 1: =(B4+C4). We need the same basic formula in cells D5 and D6 for divisions 2 and 3. Although we were able to enter two
new formulas, it is easier to copy the formula in D4 to these locations. Hover over the fillbox in the lower-right corner of cell D4, and drag down through cells D5 and D6 to copy the formula. For each copied formula, Excel has automatically adjusted the cell references to fit the data to the
correct line. This is Excel's default mode when copying formulas. It is relative addressing. 20 However, you may want to override the default setting for relative addressing of Excel. In the following example, the formula in cell E4 (in the Control column) multiplies the total sales value Dept 1
(cell D4) and the value 5% (cell B1). The result for this row is correct. However, if we copy the formula in E4 to E5 and E6 for sections 2 and 3, the result for these lines is not In the absence of other statements, Excel again used relative addressing in the formula copy. The formulas in cells
E5 and E6 are as follows: =D5*B2 =D6*B3 The first reference in each of these formulas is OK. We want the copied formulas to reference the total sales values for their respective rows (cells D5 and D6). The problem is the reference to the tax in cell B1. The master formula in cell E4 reads
correctly =D4*B1. But the copied formula in E5 refers to cell B2 (an empty cell), which results in a calculation of 0.00 dollars. And the copied formula in E6 refers to cell B3 (which contains the text value Jan), which results in a #VALUE error statement. To ensure that the copied formulas
refer to the correct control cell in this case, use absolute addressing for the reference to taxes. Absolute addressing in a formula freezes the reference to a cell, regardless of where the formula is copied. Absolute addressing can apply to a single cell, range of cells, or one, multiple, all, or
none of the cells referenced in a formula. Specify the absolute addressing with a dollar sign (an arbitrarily selected symbol) before the row reference and the column reference. For example, a relative reference in a formula to the control value in cell B1 is written as B1. An absolute 21
reference in a formula to the tax value is written as $B 1. (It is also possible to freeze only the row, but not the column by writing B1 or only the column and not the row by writing $B 1. This is called mixed addressing.) Here we have specified the absolute addressing to refer to the control cell
in the master formula in E4. Copying the master formula to E5 and E6 results in correct values for these formulas. Tip: When the F4 key is positioned above a cell or range reference on the formula bar, it traverses the four addressing options: completely relative, completely absolute,
absolute row, but no column and no absolute column, but no row. This means: B1, $B 1, B1 and $B 1. Finding Formulas Excel's Go To feature provides a quick way to identify all the calculations in your worksheet. Click Edit, Go, or click F5 to open the Go dialog box. In the Go to dialog box,
click the Special button to open the To Special dialog box. In the To Special dialog box, select Formulas and the data type you want to select. Then click OK. Excel highlights all formulas of the selected type. The Go To, Special, Error to find incorrect formulas option can be useful when
debugging a spreadsheet. If a spreadsheet is designed for data, the Data: Data Form menu can be used for data entry. Select Data Form from the Data menu. Click the New button in the upper right corner. Enter the data shown below. Use the Tab key to move to the next field box. DO
NOT use the down arrow key: It will cause the data form to become empty. This is because the down arrow will next Recording. Using the Tab key to switch from one field to the next has been a standard in the data entry industry for over 30 years. The tab key works in Excel,Microsoft
Access, and the fill-in fields found on the Internet and in all other data entry applications. The Select the select function selects the Nth element from a list. The syntax for the selection is =choose(n,firstItem,secondItem,thirdItem,fourthItem,...), where n must be a cell address that contains an
integer. The Nth point is selected by the integer. Click in cell P2. Enter =CHOOSE(O2+1,F,D,C,B,A) Note the O2+1: No null element is allowed in the selection. The O2+1 converts a GP from 0 to 1 (there is no null element of a list in Excel). Special note only for Microsoft Works users: In a
single encounter with Microsoft Works 4.0, there appears to be a null element in the selection feature.) Fill in the note column. The worksheet should now look something like this: A B C D E F G H I J K L M N O P 1 Cours e Sec t Last First S x S t HS Elem Lang T 1 T 2 T 3 Av g Pass GP
Grad e 2 MS 101 M0 8 Albert Abena a F K KH S Lelu Kosraen 8 3 8 2 8 1 82 Promo te 3 B 3 MS 101 &lt;td width= 29 en=top&gt; M0 8 Aldis Adjoa F P PIC S PCS Pohnpeia n 7 7 7 7 7 7 7 7 77 Promo te 2 C 4 MS 101 M0 8 Elidok Ama F C CH S Puluw at Puluwate s e 9 4 9 2 9 0 92
Promo te 4 A 5 MS 101 M0 8 Georg e Kwek u M K KH S Male m Kosraen 5 8 5 9 6 0 59 Repeat 0 F Diagram indicates that Office 97 does something different in a slightly different order with dialog boxes that unfortunately look very different. Design for charts is like designing data. Insert a
field name row at the top of the data. Turn the left column (first) into a column of labels. The Dist worksheet is already set up this way. Grade GP Count Column Chart What many call a bar chart, Excel calls a column chart or column chart. To create a column chart, select cells A1 through
A6. Hold down the Control (Ctrl) button and select cell C1 through C6. The control key allows you to select non-adjacent data. Always include all label rows and columns in the selection, resulting in automatic labeling of the chart axes. Click Next to exit Step 1. Click the Column Chart option
in the middle of the top row of step 2, and then click Next. Click Format Option 1 in the upper-left corner of step 3 for a simple column chart, and then click Next. The step 4 dialog box is the first of two option dialogs that are important. Here you can specify whether the data is in rows or
columns If a column or column has more than one label, you can specify multiple label rows or columns here. We only have a label column if we used the control key correctly. Excel should have chosen the following setup: In Step 5 Options dialog box, select No under Add Legends? A
single record does not require a legend. If necessary, enter a chart title, &lt;/td&gt; &lt;/td&gt; and y-axis label. Click Finish Other types of diagrams: Population Pyramid Age Female Male 0-4 -7117 7545 5-9 -7158 7932 10-14 -7288 7656 15-19 -5893 6532 20-2 4 -4703 4489 25-29 -3528
3514 30-34 -3407 3393 35-39 -2949 3049 40-44 -2456 2975 45 -49 -1660 1941 50-54 -1160 1111 55-59 -1091 998 60-64 -965 1013 65-69 -669 639 70 -74 -627 542 75-79 -281 263 80-84 -176 137 85-89 -58 41 90-94 -30 26 95-99 -8 4 There are many types of diagrams are available. The
math teacher will probably find the x-y scatter plots useful for graphics functions. Put the x-values in the first column and the y-values or a function in the second column. Excel will, with a little thought, create special diagrams that are not immediately apparent from a review of the Chart
Wizard. In an attempt to stretch the thinking, a diagram of the population size pyramid type is created below. Select the data, including the field name row and the label column. Note the use of negative values for the first column. Click the Chart Wizard button on the toolbar. Drag to set the
location of the chart on the worksheet. Click Next. Click The Bar Chart option, and then click Next. Click Option 8, and then click Next. This first of two option dialogs is important. You can specify whether the data is in rows or columns. If a row has more than one label line, you can specify
multiple label rows here. It is likely that there is no need to make adjustments for this chart: Excel 95 is likely to guess correctly based on a field name row and the label column. Click Next when you're done. In this dialog box, select Yes under Add Legend for the second options. The wizard
may have already selected yes. For two or more columns of data, a legend is informative. A field name line is required for Excel to set up the legend correctly. Enter a chart titled, x-axis, and y-axis labels. Click Finished Part. In the Chart Type dialog box, click the Options button. At the top of
the Format Bar Group dialog box, click the Options tab. Set the overlap to 100 and the gap width to 0. Click OK. Click outside the area of the chart to turn off the hash marker frame. This also puts Excel from graphics mode into regular mode. Intermediate Values Excel: Subtotals Use Excel
to generate subtotals by price and section Suppose we wanted to know if our price averages were or whether we wanted to know the relative performance of the students by status or gender. Excel can sort and summarize such data using subtotals. In order for Excel to generate subtotals,
the data must be sorted according to the criterion to be collected. In cell A1 of the Gradebook workbook sheet, click. Do not select cells: Sort suggests that only the selected cells should be sorted and mix the data. Select Sort from the Data menu. Excel should have recognized the field and
the my list radio button has... Header Row should have already been selected by Excel. A good initial design for data is important for proper sorting and subtotal. Sort by course and then by sect and then by afterload (name). Click OK. Align the subtotals from the data menu in Excel. Set to
Champagne every time you change to Sparkling Wine by clicking the downward triangle on the right side of the list box For each change in . Set the Use Function list box to Average. In the Subtotal list, click the check boxes next to T1, T2, T3, Avg, and GP. Scroll in the list box to see T1,
T2, T3, Avg, and GP. Click OK. Note the change in the worksheet: A new control panel has appeared on the left, the panel of the subtotals. At the top, three levels are indicated by three numbered buttons. Click the number 1 button to see only the Grand Average. Click the number 2 button
to see each cut average. Note the buttons with the plus characters that are displayed. When you click a plus sign button, the details open for a single section. After clicking on a plus button, a minus button appears. Click the minus button to collapse the section. Click the number 3 button to
see the list of all students. Suppose we wanted to see the average student scores by state. Changing a subtotal view is a three-phase procedure. 1. Remove the existing subtotals 2nd Resort by State (the new criteria) 3. Reapply the subtotals. The key concept is that the sort order must
mirror the subtotal in each change. Subtotals for each change when Excel moves the list down. If the states are not in alphabetical order, Excel inserts a subtotal each time the state changes from row to row Excel. Subtotals in one field cannot be used to another field without first removing
all existing subtotals, so the first step is to remove the subtotals. Phase 1: Select subtotals from the data menu, and then click the Remove All button. Phase two: Select Sort from the Data menu. Sort by state and then by sect, and then after the last click on OK. Phase 3: Set up the
subtotals. Select subtotals from the Data menu in Excel. Set to Any change in to Status by clicking the downward triangle on the right side of the list Change in Click Use Function on Average. In the Subtotal list: the check boxes can still be selected from the previous exercise. If they are not
selected, click the check boxes next to T1, T2, T3, Avg, and GP. Scroll in the list box to see T1, T2, T3, Avg, and GP. Click OK. Other subtotal functions include sum (the additive total), count (how many items), the average, the maximum value in the subset, the minimum value in the subset,
and standard deviations among other specialized functions. The total and average functions are the most frequently used functions. On the Inventory is an example of an inventory table that demonstrates the use of the Sum function to enumerate the value of the property in the A204 lab.
Click the numbered buttons of the Subtotal panel to explore the different levels of this spreadsheet. Filtering can display subsets of the data based on a specific condition. Suppose we want to show only the students who are on the shortlist, those with an average of less than 70. Start
filtering by removing the subtotals. Select subtotals from the Data menu, and then click the Remove All button. Select Sort data from the menu and sort by last name, and then by first name. Click OK. Scroll up the worksheet. Select Filters from the Menu. Select Autofilters from the zufess
menu. Small gray buttons with triangles should appear in the top row of your spreadsheet. Click the gray button in column M (Avg) to see a drop-down list of options. This list contains preset values that you can select to filter the data. Select (Custom...), the third item in the list. The following
dialog box should be displayed: Use the small Down Triangle button to the right of the equal sign in the first space under the word Avg to select a less than &lt; character. Either select 70 from the drop-down list in the next box, or type 70 in the next blank box, as shown above. Click OK. The
result is a list of students who have a shortage (under 70). If you select Print with a filter, only the displayed names will be printed. Get all your data back: Select Filters from the Data menu again and select View All in the submenu this time. Filters are another powerful use of Excel, provided
that your spreadsheet is set up in database format (field names in row one, no blank rows, one physical item per row in rows two and later). Assets that are larger or smaller than a certain number can be displayed, or students with a TOFL above or below a specific point can be displayed.
The Top Ten filter option can display just that, the top ten in a category. Pivot tables Use Excel to set up a pivot table to study course and gender averages. This section excludes the fact that the worksheet named Dist was inserted into the workbook while working on the frequency function.
Pivot tables are the easiest to set up when the is designed for data. Field names should be included in row 1 of the table with the following data. There should be no blank rows in the data. Pivot tables (called crosstabs in Microsoft Access) group data by two categories, creating summary
information such as average, sum, or count after two or more categorizations. As part of this process, pivot tables have the ability to convert categories to rows of data and convert them to field names. The result feels like a rotation of the data, hence the name pivot table. As an example, the
on the lower left side is panned to produce the result on the right. A B C D E F G H 1 State Sex T3 Average t3 Sex 2 Pohnpei F 80 State F M Grand Total 3 Pohnpei M 65 Chuuk 82.5 67.5 75 4 Pohnpei F 70 Pohnpei 75 70 7 2.5 5 Pohnpei M 75 Grand Total 78.75 68.75 73.75 6 Chuuk F 95
7 Chuuk M 60 8 Chuuk F 70 9 Chuuk M 75 The result is averages based on condition and gender. The data in the Sex, F and M column, became field names in a new row one of a table. In a sense, the data was swivelled or rotated from a column and tabulated as a field name in a new
table (hence the use of the Microsoft Access cross tab). To start a pivot table in the Gradebook workbook, click anywhere on the field row or in the data rows of the Grade worksheet. Do not select a cell, but leave the cursor in a cell within the data to be pivoted. Select Pivot Table from the
Data menu. In the first dialog box, click Next. The default Microsoft Excel list or database is usually selected and is the correct selection. In the second dialog box, click Next. If the spreadsheet is properly designed for data, Excel correctly recognized the data range. Dialog 3 shows the
screen where you can make choices for row and column groups. Drag the state (St) marked with the button from the right pane of the dialog box to the area that is marked as a line. Drag the Sex (Sx) button from the right side to the column area. Drag the Avg button from the area to the
right of the data area. Double-click the Avg button in the data layout area in the center of the screen. In the PivotTable Field pop-up dialog box, select the function average. Note that all basic features are available, including sum, average, and number, among others. These are the same
functions we encountered on the first day. Click OK. Click Next. The next dialog box requests a position for the pivot table. Click the Dist worksheet tab (created during the frequency function lesson). Click A15 (below the chart, if there is a note book). Click Finish. The data in the resulting
PivotTable summarizes averages by state and gender for the fictional College of Micronesia-FSM table. To make the data more visible: Select the data in the pivot table by dragging the mouse over the number data. Select Cells... in the Format menu. The dialog box should be opened on
the Number tab. If not, click the Number tab. In the Category list box, click the item number. Note that the default number of decimal places is preset to 2. This can be changed. For now, click OK, and the numbers in the table will appear in two decimal places. Graphing Pivot Tables The data
in a pivot table can be graphically displayed to create charts as they were handled in the second session. Be sure to select only the state and gender breakdown data, not the overall data. Total data. carefully in the diagram below and the note after the chart. The selection must be made by
dragging C20 to A16. You can't drag A16 to C20 because A16 is a button that is activated when clicking indicates that the chart displayed has been adjusted by rotating the chart 180? from the starting position. This was done by double-clicking the diagram and then selecting the 3D view
from the Format menu. In the 3D view dialog box, the rotation was set to 200? (Initial rotation was 20?). Pivot tables are best generated by good data designs. In return, good data drafts are created taking into account the effects of the pivot table. A good design requires that each row of
data be a single object or instance, not an aggregate of data. Gradebooks produce almost naturally good data designs: a single student in a single class per row (one student seat). Other applications may require foreboding. In a study of lizards, for example, proper design of a good table is
likely to list each individual lizard in its own series. This would be unlike a table where each row was a site and the data was the number of lizards in that location. The following fictitious table is not well thought out from the pivot table's perspective. Although, for example.B the original counts
may have indicated the number of females with tails, the resulting table has lost this information. The design is also prone to typographical errors that lead to internally inconsistent data: examine the sum of the number of males and females on trees. Number of females Number of females
Num w / tail beach 2 1 1 0 pond 6 3 5 5 river 8 5 3 4 rocks 7 5 2 7 tree 10 6 5 9 A better design would have been: location sex with tail tree F 1 Tree F 1 Tree F 1 Tree F 1 Tree F 1 Tree M 0 Tree M 1 Tree M 1 Tree M 1 Tree M 1 Tree M 1 Tree M 1 Tree M 1 Pond F 1 Pond F 1 Pond F 1
Pond M 1 Pond M 1 Pond M 1 Pond M 1 ... And so on. The resulting table can be subtotal or pivoted to get accurate summary information. Although the original data table is lengthy, most reports use the results of subtotal calculations and pivot tables. The table may have typographical
errors, but the totals are at least consistent with the data, there is no internally conflicting data. Typos probably also do not affect the counts in the previous table. VLookup function In Excel, the VLookup function looks for a value in the left-highest column of table_array and returns the value
in the same row based on the index_number. The syntax for the is: VLookup(value, table_array, index_number, not_exact_match ) is the value to search for in the first column of the table_array. table_array are two or more columns of data that are sorted in ascending order. index_number
is the column number in table_array of the matching value must be returned. The first column is 1. not_exact_match determines whether you are looking for an exact match based on the value. Enter FALSE to find an exact match. Enter TRUE to find an approximate match, which means
that if an exact match is not found, the VLookup function searches for the next largest value that is less than the value. Simple Vlookup Tutorial Let's say we get the following sales table: If you want to get Dan's January sales (hence cell B3), the vlookup function will be: =vlookup(Dan ,
a2:c4 , 2 , false) Let's go over the different parts of the function in simple English (note the highlighted parts in the following sentence, removed directly from the formula): The function searches for the word Dan in the first column (left column) :c4. It retrieves the adjacent value in the 2nd
column (hence the January column). The word False tells the function to find exactly the word Dan, and not something close or similar. One way to make the function more readable is to name the table and use that name in the vlookup function: select the table (no need to include the
header row), and write a name in the name field (which is at the top left of the screen). In our vlookup example, we used the name salesTable (Try to avoid using spaces). Therefore, the function can now look like this: =vlookup(Dan,salesTable,2,false). And if you don't always want to get
Dan's January sales, but to get the name written in cell A6? =vlookup(A6,salesTable,2,false) And if you want the function to get sales in February (instead of January)? =vlookup(A6,salesTable,3,false) When and how should you use the Vlookup function? If you have a table of data and want
to retrieve specific information from it. If you're looking for a name in a phone book, perform a real vlookup action: you'll find your recipient's name in the first (most left) column, and when you find it, get the number that appears next to that name. An implementation of vlookup in Excel could
be: You have an Excel spreadsheet with student names and their grades. You want to be able to enter a student name somewhere in the sheet and get its grade immediately (based on the data in the table). To achieve this, you can use Vlookup: the function searches for the student's name
in the first column in the table and retrieves the information that is next to the name in the second column (this is its grade). Check the video links above, to learn exactly how to write and implement the vlookup function in the worksheet. Another vlookup example: You have a large table
consisting of thousands of bank accounts. You want to retrieve information about specific accounts on another worksheet. To achieve this, you can enter these specific account numbers and a Vlookup function next. The function searches for the account numbers in the large table and
retrieves relevant information from it. The difference between Exact match and Closest match: If you use the Vlookup Excel function to retrieve information based on a student name or bank account number, you can't let it find something near or similar to Jake or near account number
3647463, but it needs to be found accurately. But sometimes you have a table, the ranges defined, for example: 5,000 USD – Small Deposit 20,000 USD – Mean Deposit 100,000 USD – Large Deposit 500,000 USD – Huge Deposit If you want the Vlookup to find the description for a deposit
of 23,000 USD (the middle deposit should retrieve), you will find it after a close match, and it will find 20,000 USD. This is very useful when it comes to appointments. Take a look at the following table: 04/01/2008 - Timely payment. 01.06.2008 - Late payment (small fine). 01.08.2008 - Very
late with payment (big fine). If you want to find out what happens with a payment on 14.07.2008, the function will refer it to the date 6/1/2008 and get us Late with payment (small fine). Please note - the function always retrieves the smaller match (if it does not match exactly). A drop-down list
allows you to select a value from a list instead of typing it. Create a drop-down list in Excel 2010: 1. Write the list to a location within the worksheet. It is recommended that you sort it alphabetically in ascending order, because this is the order in which they appear in the drop-down list. 2.
Name the list by selecting its range and writing its name in the name field. In this example, we called it Cities: 3. Select the cell in which to display the drop-down list. In this example, we selected cell B2: 4. Select the Data tab from the ribbon. 5. Click the Data Validation button. It will look like
one of the following two examples, depending on your screen resolution: OR: 6. A dialog box will be displayed. Click the words Each value and select List. 7. Click in the Source text box and write =[the name you gave to the list] (in our example: =cities). 8. Click the OK button. Finished! Now
you have a drop-down list in the selected cell. Importing a delimited file into Excel Whether it's created manually or exported from another software application, delimited-delimited files are often used to store important data. Problem with data is that it is not very valuable unless you have a
way to manipulate and study it. Although delimited files are a nice way to store data, it is not very convenient to try to study the data in the raw form of these files. When you import the delimited file into MicrosoftExcel, you can use all of Excel's tools for analysis. Use. and to clearly present
the results of your analysis. Step 1 Select Open from the Microsoft Excel File menu and navigate to the folder that contains the delimited file. Make sure you have selected the option to view all file types. If you don't, you can't see your file in the folder. Double-click the file name to open it.
Excel automatically enters Text Import Wizard mode. Step 2 Select Separate as the file type that best describes your data on the first screen of the Text Import Wizard. Then click Next to move to the next screen. Step 3 Select the delimiter used in The Delimited File. If you didn't know what
the delimiter was before you started importing the file, you can usually scan the data and determine which character is used. In our example, the file is separated by commas. After selecting the delimiter, click Next to continue. Step 4 Assign the data format to each field you import. The
default data format is General, and this is the format you should keep unless one of your data fields contains dates or consists of data that you want to keep as text. Click Next to complete the import after you have completed assigning data formats to all fields. Step 5 Save the resulting
spreadsheet as an Excel file. Now you can edit and study your data using the tools in Excel. Excel Scenario Manager Excel is a tool that can be used to determine various projected results of data by modifying different cells within a worksheet model. A scenario is a set of values that Excel
can store for you and automatically replace on your worksheet. This means that you might have a spreadsheet with numeric data that is relevant to a specific date, month, topic, or whatever, and Scenario Manager allows you to enter different values in the worksheet to predict the result of
the data. These values (or scenarios) can be retained for future use and are stored in a hidden part of the workbook that can be retrieved by asking Scenario Manager to view the scenario that uses these specific values. Keep in mind that scenarios are just another version of the same
worksheet, with each other version using a different set of input values in the named cells. For scenarios to work properly, you should first create a basic or standard scenario Set up a worksheet in Excel. This default scenario defines all other scenarios. Go to Tools&gt;Scenarios to enable
Scenario Manager. A message appears indicating That Es No Scenarios are defined. Select Add to add your default scenario. Give your scenario a name, a base, an original or default name, or a name that you can easily identify are fine. Click to switch to the next Cells field: You will notice
here that the cell that is your active active in the workbook are referenced here. Click the Collapse dialog button to collapse this dialog box up so that you can easily select the cells from the worksheet you want to reference. Click the Collapse dialog button again to expand the full Scenario
Manager field. To enter a comment, click in the Comment: box and do so. There are two options at the bottom of this dialog box. They are prevent changes and hide, with Prevent changes being the default. If you select Prevent changes, all scenarios are locked and cannot be edited. It is
important to note that you MUST also protect your worksheet using the Tools&gt;Protection&gt;Protect Sheet option for this option to take effect. If you then want to edit their scenarios, you must first unprotect the worksheet and then turn off the Prevent Changes option to continue. The Hide



option when this option is selected works exactly as I said and hides your scenarios. This option also requires densheet protection for it to take effect. Click the OK button. When you click OK, the Scenario Values dialog box appears. Here you must enter values in the scenario cells.
Because the first scenario is your default scenario, the values in the cells we specified in the Change Cells: field have been applied, so we don't have to make any changes here, we just need to click the OK button. This will take us back to Scenario Manager and you will see the name of
your scenario. Adding Scenarios The number of scenarios you can apply to your worksheet model is unlimited. Adding a scenario is essentially the same as creating a default scenario. Go to Tools&gt;Scenarios to view the Scenario Manager dialog box and select Add to see the Add
Scenario dialog box. Under Scenario Name, give the new scenario a name. You don't need to make changes to cell changes: If the cells we nominated in your default scenario are displayed here. Click OK. This displays the Scenario Values dialog box, and this time you must change the
values. Click OK. You now have two scenarios available. Now, when you view scenarios, you can view your scenarios to see how they change the outcome of your data by asking Scenario Manager to view a specific scenario. Select Tools&gt;Scenarios Click the scenario name you want to
click on View. Click the next scenario name, and then view the values on the worksheet again, and then read the values on the worksheet again. Click Close if you no longer want to view your scenarios. Excel Consolidation for Consolidating and Summarizing Data from Different Worksheets
Consolidation is the process of combining values from multiple data areas either from the inside same or different workbooks. It can be used to summarize data from different worksheets in master worksheets and to create a report with a variety of calculations. Consolidation is in the data
menu; Data&gt;Consolidate. Consolidate by position Used when worksheet data is the same in order and position. This type of consolidation is the easiest and works with a layering operation. This means that after you open the workbooks that you want to consolidate, you specify the
ranges you want to consolidate, and the values on one worksheet are overlaid to the values of another worksheet until all worksheets are overlaid. You can then select the calculation to run for your data. No formulas are used to perform this consolidation type, although you can set up the
consolidation to update automatically when the source data changes, by creating the Links to source data field, not manually setting the default. Consolidate by category Used when data is organized differently but has identical row and column labels. This type of consolidation is a little
more difficult to perform, but works almost the same way. If you select your data to consolidate, this time you must include the row and/or column headings. Excel then examines the row and/or column headings and can draw the layout of your worksheets and consolidate your data for you
by examining the contents of the areas to use. Consolidate with 3D formulas that are used when worksheet data does not have a consistent layout or pattern. 3D formulas are formulas that refer to multiple worksheets and can be used to combine this type of data. A formula like
=Summe(Sheet1! A6,Sheet2! C12, Sheet3! H9) can be used to add cells from different worksheets to consolidate them into a summary sheet. This consolidation type does not use the Consolidate under Data&gt;Consolidate dialog box, but is created entirely as a formula, so it is
automatically updated when the data that depends on changes calculations with addition, subtraction, division, and multiplication Excel is an electronic calculation that can be compared to a large sheet of paper, divided into 256 columns and 16,384 rows in which we can store text and
numbers. But the great advantage of this program is how values and texts stored in the sheet can be manipulated so that the user finds best by a large number of Formula that can be used at a specific time. But first, what exactly are formulas? Formulas are expressions that make it very
easy to perform precise and fast calculations and operations. With them we can work with numbers, cell addresses, texts and conditions, to name but a few. When you define a formula accurately, it calculates the correct response when it is introduced into a cell and provides a constant
update by recalculating the result. Is. when any value is changed. We can use mathematical functions to create formulas that make simple or complex calculations, and those that can be used in a formula are as follows: It is a logical operator that is used in comparison. For example, uses H
&gt; greater than F5&gt;H7 &lt; less= than=&gt;&lt;H3 == equal= to= g5=H6&gt;&lt;/H3&gt;&lt;&gt;Unlike G5oC10 &gt;= Greater or equal 14&gt;=D2 &lt;= equal= or= less= than=&gt;&lt;/gt; &lt;=G6 tor= += addition= b1+b7= -= subtraction= x4-9= *= multiplication= c9*d4= division= d7/a2= a=
gn=top&gt;Exponential G5A9% Percentage 235*10% Functions Excel has predefined functions that enable a variety of calculations and tasks. All you need to do for a function to work is to provide it with the appropriate values to perform the calculation. The functions must start with the
equal sign (=) to interpret them as formulas, not text. It is also advisable to enter the name of the function and cells in capital letters. SUM Formula i.e., =SUM (A1:A7) The formula adds all the values it finds in address Al to address A7. The formula will always be the same; all that will
change are the addresses of the values you want to add. See Example: In this example, all values were added from Al to Dl. The formula used was =SUM(A1 :D 1) and when you press Enter, the result was displayed. In this case, the result was 45. To achieve this result, you must do the
following: 1. Place the cursor in the cell where the result of the calculation is stored. 2. Enter the equal sign (=) to indicate that a formula should be entered into the cell. 3. Insert the address of the cell that contains the first data value to add. 4. Enter the plus sign (+) to indicate that a
supplement should be made. 5. Enter the cell address that contains the next result to add, etc. 6. Press Enter. However, there is an easier way to add % using the AutoSum button. To work with the AutoUm button, do the following: 1. Select the values you want to add. 2. 2. Then click on
the AutoUm button and the answer will be displayed. Subtract, you've created a complex table of all your expenses over the last six months and want to know what balance is left to make an investment. The procedure is very simple: 1. Select the cell that holds the result of Opera 2. Enter
the equal sign (=) to indicate that a formula is entered into the cell should. 3. Insert the address of the cell that contains the first data value from which to subtract it. 4. Enter the minus sign (-) to indicate that a subtraction should be performed. 5. Enter the cell address that contains the value
to be subtracted. 6. Press the Enter button to complete the process. The result should be as shown in the picture. Multiplication Formula The four basic mathematical operations have similar&lt;/=G6&gt; similar&lt;/=G6&gt; in Excel. In the case of multiplication, you only need to use the same
schema that you used for subtraction and change only the subtraction symbol for the subplication (*). See Example: 1. Select the cell to contain the result of the operation. 2. Enter the equal sign (=) to indicate that a formula should be entered into the cell. 3. Insert the address of the cell that
contains the first data value 4 to multiply. Enter the sign (*) to indicate that you want to multiply. 5. Enter the cell address that contains the value to multiply. 6. Press Enter to complete the process. Division Formula To create a division, you must use the formula in the same way as before. All
you need to do is change the character to Division (/). Procedure: 1. Select the cell that holds the result of the operation. 2. Enter the equal sign (=) to indicate that a formula should be entered into the cell. 3. Insert the address of the cell that contains the first data value to split. 4. Enter the
division sign (/) to show that a split should be made. 5. Enter the cell address that contains the value to be split. 6. Press Enter to complete the process. Copying and moving formulas If you perform many calculations in a spreadsheet, you do not have to enter the formula every time you use
it. You can either copy them or simply move them. Copy Formula To copy a formula, the procedure is as follows: 1. Click the cell to copy. 2. Access the Edit menu and select Copy, or use the Ctrl + C. 3 key combination. Click on the cell or area to which you want to copy the formulas. 4.
Open the Edit menu and select Insert, or use the Ctrl + V Move Formula link You can also move a formula that will require you to re-enter it every time it is needed. 1. Select the cell to move. 2. Open the Edit menu and select Cut, or use the key combination Ctrl + X. 3. Click on the cell or
range to which you want to move the formulas. 4. Open the Edit and Select Insert menu, or use the abbreviation Ctrl + V. Formulas A simple step-by-step project that explains the basic formulas In the previous pages you were introduced to some of the basic concepts about applying
formulas in Microsoft Excel. Now we will learn how to get the four basic operations in mathematics into the addition, subtraction, multiplication, and division. Supplement 1. When Excel is open, create a sheet with the Products, Value, and Quantity items. 2. Now fill in the items with the
values you want to add. You can also use numbers with decimal places. 3. To apply the formula for addition, click cell C4 and enter the formula =C2+C3. It will give you the answer to the sum of the two numbers. Subtraction 1. To learn how to use the subtraction formula, use a sheet with
the items Products, Value, Quantity, and Sold. 2. Fill in the Sold field with the number of products that are no longer in stock. 3. Click cell E2 and enter the following formula =C2-D2. In this case, the response returns the result of subtraction multiplication 1. To multiply numbers, we use the
same sheet from the previous example. 2. Click cell E2 and enter the following formula; =B2*D2 and press Enter 3. Repeat the same operation to perform the calculation for black pen by changing only the cells (=B3*D3). Division 1. Now we will make a division with values that we have in
our table. (products, carton price, carton quantity and unit value). 2. Fill in the corresponding numbers of the items (products, value, quantity in box) to determine the unit value. 3. Just click in cell D2 and enter the formula =B2/C2. This will return the result of dividing the two numbers. 2
Beyond the E=MC Basics Learn to use the most important functions of Excel If you want to know how many students have not reached the final average of a table consisting of several names, you can use the formula _ COUNTBLANK. It counts the cells that have no value. Follow these
steps: 1. Create a sheet with the columns 'Student' and 'Average'. Fill the cells with the names and values of their scores. 2. To know how many students have not reached the required average in the sheet, enter the following formula: =COUNTBLANKB2:B7) 3. To understand the function:
=COUNTBLAXK is the name of the formula; (B2:B7) refers to the addresses of the cells. Other formulas COUNT: Calculates how many cells contain numbers and numbers in the lists of arguments. For example, if all cells in A1:A10 contain numbers except cell A5. This is empty and A7
contains a word, then: COUNT(A1:A10) returns the answer 8. DCOUNTA: Calculates the number of cells that are not empty and the existing values in the argument list. For example, if all cells in Al :A10 contain numbers, except for cell A5, which is empty, and cell A7, which contains a word,
then DCOUNTA(Al:A10) returns the answer 9. STDEV: Calculates the standard deviation from an average within a sample. The standard deviation is a measure of the degree of variation of values relative to an average value. For example, let's assume that 10 tools manufactured in the
same machine during production are collected as random selections and then measured to check their breaking strength. The values of the sample (1345, 1301, 1368, 1322, 1310, 1370, 1318, 1303, 1299) are stored in cells A2:E3. STDEV estimates the standard deviation of the breaking
resistance for the entire sample. STDEV(A2:E3) equals 27.46. ABS: Returns the absolute value a number. The absolute value is the same number without a plus or minus sign. Examples: =ABS(-4) gives us 4 =ABS(4) also gives us 4 ROUND: Rounds the number to the next determined
number of decimal places. Examples: =ABS(-4) gives us 4 examples: =ROUND(2.149;l) gives us 2.1; =ROUND (1.475;2) gives us 1.48; =ROUND (2,5;-1) gives us 20. INT: Rounds a number to the nearest integer. Example: =INT(8.9) gives us 8. TRUNCATE: Crop the number according to
the number of required decimal places. Examples: =TRUNC (8.97;0) gives us 8; =TRUNC (8.97; 1) gives us 8.9. Conditional features Learn how to turn your Excel spreadsheets into efficient data analysis tools. When we first opened Excel, none of us ever imagined the performance and
capacity of all these rows and columns. Behind this great table are hundreds of formulas, functions, and filters among other regressions that improve excel's reputation as the best spreadsheet editor. In order to get the most out of this tool, however, it is necessary to know what these
regressions are and how to use them: otherwise Excel will be no more than a huge database built up of hundreds of rows and columns. In this step-by-step tutorial, we'll look at conditional functions - formulas that allow us to create sheets that give us results based on specific given
conditions. Check out the examples of If, And &amp; Or features that we present here, in this step-by-step guide, and customize their use to suit your needs. Function: AND &amp; OR In the following example, we define the status of each student at a university according to their graduation
grade and the number of absences. To pass, the student must reach an average of more than 7 and the number of absences must be less than 10. Only if both conditions are met will their status be TRUE, which means that the student's performance has met both arguments. If the student
does not meet both requirements, the message returned is FALSE. Let us also give an example in which it is not necessary to meet all the conditions. In this case, if only one of them is true, then the returned message will now be TRUE. First step: To create a student's status as specified,
you must use the AND function. In cell A1, enter a value for the student's final average grade and the number of absences in B1. In cell, type CI =AND(A1&gt;7,B1&lt;10). second= step:= you= can= add= more= arguments= to= the= function= using,= continue= typing= the= function,=
putting= in= the= first= argument:= a1=&gt;7. Type ; and continue with the second argument: B1&gt;10 and Sie die Klammern. Die endgültige Formel sollte wie folgt aussehen: =AND(A1&gt;7,B1 &lt;10). Third Step: To finish, press Enter. Now, using the function AND, the result will only
return TRUE if all the arguments comply. IF Test: In this attribute, an expression third= step:= to= finish,= press= enter.= now,= using= the= function= and,= the= result= will= only= return= true= if= all= the= arguments= comply.= if= test:= in= this= attribute,= an= expression=&gt;&lt;/10).
Third Step: To finish, press Enter. Now, using the function AND, the result will only return TRUE if all the arguments comply. IF Test: In this attribute, an expression &gt; &lt;/10).&gt; &lt;/10).&gt; to see if it has either a TRUE or FALSE value if true: The returned value if the test argument turns
true. For example.B an argument as a sequence of letters such as Approved, and this argument for the test is set to TRUE, the IF Approved function displays in the appropriate cell of the formula. If the test is TRUE and Value, if true is empty, the argument returns zero. Value if false: The
returned value if the test is FALSE. If this argument is, for example.B a sequence of the characters Failed, and the test argument is FALSE, the if displays Failed function. If the test is FALSE and value if false is empty, the value zero is returned AND(argument1; argument2..) In this function,
all arguments must be considered for the function to return true. The AND function can also be used in conjunction with the IF function and turns it into a dual function. Example =AND(5&lt;8;13&gt;2)-&gt; Function returns True because all arguments are true. =AND(4&gt;5;7&gt;6)) —&gt;
Function returns False because only one of the arguments is true. OR Unlike the AND function, the OR function requires at least one of the arguments tested to return TRUE. This function returns only the value FALSE if all arguments tested prove to be false. Examples =OR(1 &lt;2;8&gt;4)
—&gt; Function returns True because all arguments are true. =OR(1&gt;2;8&gt; 4)) -&gt; Function returns True because two of the arguments are true. =OR(1&gt;2;8&lt;4) —=&gt; Function returns False because all arguments are false. Fourth step: so that the formula returns TRUE. Even if
only one of the two arguments is TRUE, use the OR function. Only change the formula to OR instead of AND. Fifth step: There is another logical function that is used to reverse the logical value of an argument, which means if the value of a cell is true, the return will be FALSE, and if the
value is false, the return will be TRUE. This function is called NO. Sixth Step: For example, type .B in cell D1: =NO C1). In addition, it is also possible to combine all these functions to a more specific result. i.e., =ANDORAVE D8:D16 &gt;7; E8=10). Functions: IF &amp; AND Calculate the
retention of income tax according to each employee's salaries. First step: Using the same table of data for positions and salaries that we have seen before, we now calculate the retention of income tax according to the different salary classes. Second step: For this task, add a new column
that appears next to the salary should be placed. Give it the tidal tax, as shown in the illustration. Third step: In the Taxes column, we calculate the tax withholding for each employee. In this case, we need to use the combination of the IF and AND functions so that the condition&lt;/4)&gt;
&lt;/2;8&gt; &lt;/8;13&gt; &lt;/8;13&gt; these three conditions. Fourth step: Click cell D4 and type part of the formula =IF(C4&lt;=500; Liberated; (Without inverted commas). If the condition applies to the cell being tested, no tax is withheld for this line. Fifth step: To test the second payband
between INR 500 and INR 1,000, add the AND function so that the formula becomes i'=IF(C4&lt;=500;. Exempt;IF(AND(C4&gt;500:C4&lt;= 1 000 ;50;. Sixth step: To end the formula, add argument 100 to the formula so that the tax withholding for the upper payband is above INR 1,000. The
full formula is =IF(C4&lt;=500:Exempt;IF(AND(C4&gt;500; C4&lt;= 1000 :50: 100))The IF &amp; OR employee benefits functions according to the paybook and department in which each employee works. First step: To illustrate the combined use of the IF and OR functions, we will insert two
columns into the position and salary table - Health Plan and Department. Second step: In this case, the company offers the benefit of a health plan only for employees who receive up to 1,000 INRs or work in the sales department. Third step: To check which employees are entitled to this
benefit, select the first cell in the Health Plan column, which in our case is cell E4, to insert the function. IF(B4=Manager;2500))), which corresponds to the condition test for the three positions and their respective salaries. Fourth step: If the numbers are different now, try changing the second
sign = in the formula to CI for &lt;&gt;. The result changes to TRUE. Fifth step: To copy the function to all rows of the Content field, simply place the mouse pointer in the lower-right corner of the cell and drag until you reach the end of the table- ; Logical operators To perform conditional
calculations, you must pay particular attention to logical operators. Open an empty spreadsheet and enter the formulas for the test. In this example, you can check how two of the operators are word = equal) and &lt;&gt; (different). First step: Select cell Al from your table and enter 10. Then
select cell B, and enter 10. Second step: In cell CI, enter the following formula =A1=B1. It will test the values and return TRUE. Third step. If you change the value in one of the cells, the message in C1 automatically changes to FALSE. Operators In the opposite table (bottom/top), you will
find all logical operators used in conditional functions, complete with a description, examples, and the results that are achieved. ft* Operator Description = Equals returns TRUE if the two values =A2=A5 ARE TRUE &gt; Greater than TRUE is returned if the first value is greater than the
second =A2&gt;A5 IS TRUE &lt; Less than TRUE if the first value is less than the second =A2&lt;A5 TRUE. Is. True returns greater than or equal to TRUE if the first value is greater than or equal to the second =A2&gt;=A5 TRUE &lt;= Less than or equal to TRUE, if the first value is less than
or equal to the second =A2&lt;=A5 TRUE &lt;&gt; Different returns FALSE if the two values compared are different =A2oA5 FALSE Percentage Formulas Discover how this simple but useful function, step by step &gt; percentages, are used very often in expressions that reflect _ increases or
quantity decreases. We often hear phrases such as: petrol has increased by 10% (meaning that for each BENZIN value of 100 INR there was an increase of INR 10 ; the customer received a 20% discount on all goods (meaning that for each INR 100, a discount of INR 20 dollars was given
on the price); of all players who play for Brazil. 90° o are crack players (meaning in 100 players who play for the squad, 90 are exceptional scorers). Two simple examples: 1. A shop launches a promotion of 10% Off on all its products. If a merchandise item originally costs INR 120.00. What
will be the discount price? The discount is 10% of the value of INR 120.00. Therefore we deduct INR 12.00 from INR 120.00: 120- 12 =108 Ab, with the selling price we only pay INR 108.00. 2. One class has 100 students, 40% of whom are girls. How many girls and boys are there? The
number of girls is: 100 x 40/100 = 40 And the number of boys can be determined as: 100 - 40 = 60. Complicated? Although the examples are simple, Excel also allows such obvious calculations to be made quickly and easily. The calculation is the same as if you were using a calculator, but
the difference is that you add addresses to the formula. Follow the step-by-step tutorial. 1. Imagine that a customer makes a purchase of INR 1,500 and that you want to give a 5% discount on the value of the purchase. Create a table with the fields: Customers, value, discount and price to
pay. 2. After you format the spreadsheet, fill it in with the name of the customer and the value of the product. In the With the Discount stamp column, insert the formula to determine the percentage. 3. In the cell under Discount, enter the formula =B2*5/100 or even =B2*5%. Press Enter to
check the result. 4. To determine the actual value of the product to be purchased from the customer, enter the subtraction formula = B2-C2. 5. To understand the formula: B2 refers to the address of the purchase value, * is the multiplication character, while 5 /100 is the value of the discount
divided by 100. 6. In this formula you multiply the address of the purchase value by 5 and divide by 100, which generates the value of the discount. Is. DATUM automate the insertion of days, months and years into your spreadsheets. If you are working with Excel spreadsheets and often
need to insert dates, follow this tutorial. You can use the date formula to enter a date in a cell without having to enter it. You can also discover every day of the week that corresponds to a specific date. Formulas for appointments and days of the week. 1 . To insert today's date into a
spreadsheet, all we need to do is position the cursor in the cell where you want the date to appear and enter =TODAY (). 2. You can also insert the day of the week that corresponds to a date. By default, the tag is specified by an integer, which by default varies between 1 (Sunday) and 7
(Saturday). 3. Select a cell and right-click it. On the Number tab, select the item date and under Type, select the format with the day of the week and the date. 4. Enter the date in the cell to discover the day of the week that it corresponds to. Press Enter. 5. Note that Excel specifies the day
of the week of any date. 6. You can discover the day of the week of several appointments all at the same time. Select all cells with the dates and change their format to day of the week. To calculate the number of days between two dates, simply subtract them. For example, B2=08/08/2000
and 83=27/08/2000. The formula B2-B3 gives us the resulting number of days. In this example, the result is 19. Note that the date in the cell must be formatted as a number. Otherwise, Excel specifies a date in response instead. Maximum, Minimum, And, Average Learn how to discover the
extreme values and averages in spreadsheets. Excel provides a number of tools to make the user's daily routine easier. One of them is the ability to get the average from a list of Ranging values. Apart from that, can you also find out which numbers in the lists are the maximum and
minimum values? Follow the next step-by-step guide and see how easy it is to use this resource The formula for Maximum Imagine You have a sheet with the name and age of different students in a school and need to know what the maximum age of a student is. To discover this, you only
need to use the maximum formula. 1. Create a table with the names and ages of students at a school. Enter the names in column A and the age groups in column B. 2. Now let's enter the maximum age in cell A15. Cell B15 will be where we want to display the result of the maximum
number. 3. In cell B15, enter the =MAX (B2:B14). Note that B2 corresponds to the first cell of the figures, and B14 is the last. If you send date and hour deduct, verify that you created the formula correctly. The dates and hours must be positive values. If a date or hour formula returns a
negative result, Excel is displayed in length Cell. Formula to determine the minimum This formula shows the minimum value of a range of cells. To discover the minimum weight of one of the children in our list, do as follows. 1. Let's use the same table that we saw for the maximum formula,
but we'll add another column to include the relative weights of the students. 2. Now. we will enter the data about each student's weight. Write in cell CI5: Minimum weight. 3. In cell D15. You must enter the formula =ML(C2:C 14). If you use the same values as shown in the image, the result
is 25. Formula for determining the average The formula for determining the average is very useful to determine the average value (e..B. age) in a long list or table. 1. Now let's discover the average age of students at school. To do this, we use the same sheet that we used in the previous
examples. 2. Now we enter the data on the weight of each student. Write in cell CI5: Minimum weight. In cell D15, you must enter the formula =ML(C2:C 14). If you use the same values as shown in the image, the result is 25. 1. Insert a row into the sheet and write average in cell A15. In
cells B15 and C15, you get the average age and weight of the students. 2. In cell B15, type =AVERAGE(B2:B14) to determine the average age, while in cell C15 the type is =AVERAGE(C2:C14). Interaction between tables Create a formula to create calculations with data from separate
tables Imagine that you have a plan for household expenses, and that each sheet of the file contains the totals of each family member's income and expenses. You can link the result of two or more sheets to make things easier, for example.B to show the running balance after each person
makes each payment. In this step-by-step tutorial we will use a plan with the expenses of a couple and we will include in our balance the balance of funds after payment of each of the invoices. Follow these steps: Office Assistant and Functions If you want to include features in your
spreadsheet and can't easily remember them, you can use the Excel Function Wizard. You can access it from the Insert, Function, menu. There you will find a whole series of formulas and explanations about what each of them is doing. To access one of them, click the name, and then click
OK. A screen appears on which you can determine which cells make up the calculation. Excel also displays the formulas that were last used by the user. 1. In the spreadsheet that you want the formula to contain, you have a cell in which you want to insert the result of another sheet. 2.
When you create a new formula, enter = (equal sign. 3. In order to Use another sheet in the open workbook to click the sheet that contains the cells you want to link. 4. After opening the sheet that gets the result, insert the formula as in the example: =Cristina! C 10+Marcelo! C 14. 5. To
understand this formula: =Cristina! is the name of the table in which the number to add is: C10 is the cell that contains this value in the sheet; Marcelo! is the name of the second sheet, and C14 is the cell with the second value to add. 6. To complete the formula, press Enter. Note: If you
have created a table other than the example, the ASSIGNMENTS Assignment Assignment:1 NAME OF THE STUDENT HINDI ENGLISH History MARATHI GEOGRAPHY RAHUL 58 48 74 85 71 RAJ 74 85 48 74 65 ROCKY 65 58 54 82 25 RAHIM 86 69 71 65 74 WAHAB 57 68 91 58 47
ANIL 56 67 81 45 55 SACHIN 75 74 58 75 75 BE DONE : Take a new sheet and create the data as shown. And do a lot of the formula like ( Total, Avg., Min, Max, Grade, Result) option to be used: Home Panel is to use Assignment 2: STEPS TO BE DONE: Open a new file and edit the
data. Cut the markings of the sachin s and paste it into Wahab data. As shown above. Option to be used: Home Panel clipboard option to be used assignment: 3 STEPS TO BE DONE: 1. Insert a column. 2. Delete cell. 3. Delete line. 4. Change the size of the rows, columns to be used to 25
and 23 option:Home Panel Assignment: 4 STEPS TO BE DONE: 1. Open a file and enter the data as specified below. 2. Use different text alignment for the first line. 3. Change the font and font size of the second line. 4. Use Border to outline the text. Option to use: Home Panel font,
paragraph assignment: 5 STEPS TO BE DONE: Open the file and enter the data as specified below. Sums the products of all four products and create a chart with details on how to sell all three products for all four products. Option to use: Insert Panel Charts option. And total formula
assignment: 6 STEPS TO BE DONE: Open a new file and enter the data as specified below. Use the pivot table and pivot chart and analyze the data option to use: Insert Panel &gt; Tables &gt; Pivot Table Assignment: 7 STEPS TO BE DONE: Create a datasheet as shown below and run
the following 1. The Page Break option prints columns B-3 on page 1 and F5 on page 2 2. Set the margins of page 0.75 left &amp; right and 0.75 top &amp; bottom 3. Print the grid rows 4. Show IMAC SOLUTIONS PVT. Ltd. Corporation Ltd in the and page number in the footer 5. Preview
the document in the print preview OPTION TO BE USED: 1. Page break 2nd page Setup 3. Print preview assignment: 8 STEPS TO BE DONE: 1. Select a column and sort according to ascending order. 2. Select a different column sort in descending order again. 3. Select three columns and
sort first column in ascending order, two more in descending order OPTION TO BE USED: Data Panel &gt; Sort and Filter Assignment: 9 STEPS TO BE DONE: Create a datasheet as shown below and check the Rate field to accept at least 1 to 2 months of dates. Usage option: Data Panel
&gt; Data Tools Solve question 1. Which of the following versions is the latest version of Excel ? Excel 2000 Excel 2002 Excel ME Excel XP 2. Excel files have the default extension ? XLS XLW WK1 123 3. A typical worksheet has the number of columns ? 128 256 512 1024 4. All formulas
in Excel start with ? % + = - 5. The split symbol is ? . / D D ) 6. The multiplication arithmetic operator is represented by which of the following symbols? * / X 7. On an Excel sheet, the active cell is indicated in by ...? A dark wide border A dotted frame A flashing frame None of over 8. Use the
key combination F11 to create a chart on a chart sheet? A standard chart A 2-dimensional column chart A 2-dimensional bar chart A 3-dimensional line chart 9. You can print ? A range of cells by range name An entire worksheet A single worksheet All of the above 10. You can only create a
horizontal page break by selecting first? A row below the row in which the page break should occur a cell in row 1 A cell in column A a and c 11. Can you create hyperlinks from the Excel workbook? A website on the corporate internet A website on the Internet Other Office 97 application
documents All 12. The advantage of using a spreadsheet is? Calculations can be performed automatically. When you change data, calculations are automatically updated more flexibly. The intersection of a row and column is called? Data a field. a cell and equation 14. There are three
types of data found in a spreadsheet?? Data, words, number equations, data, number words, numbers, label numbersFormulas, labels 15. If you...... press, the cell accepts your input as content.? Enter Ctrl+Enter Tab Insert 16. Which, if you press ......, does the cell accept your input as
content.? Esc Shift Return Tab 17. What is not the advantage of using computerized spreadsheets? Flexibility of movable entries Speed of calculation ability of generation tables Cost of initial setup 18. To select multiple cells or ranges that do not touch each other, you would want to ...
when selected? Hold down the Ctrl key Hold down the Shift key Hold hold the Alt key Ctrl + Shift 19. A constant is another name for this Number Formula Formula Description Creating Macros in Excel The Visual Basic Editor (VBE) is the easy-to-use programming environment in Excel. You
can program VBA in any version of Microsoft Office, including MS Office 97, MS Office2000, MS Office2002, MS Office2003, and MS Office XP. Xp. The reason for vbA is due to the limitations of using the built-in functions of VB and macro recording. With VBA, you can create some very
powerful tools in MS Excel, including financial and scientific applications such as retrieving financial data from the Internet and linear programming. The VBE is integrated with Excel and can be opened from the Excel Tools/Macro/Visual Basic Editor menu bar. Open Excel and click the ALT
key on your keyboard (left in the space bar), hold it, and click the F11 key. Here's the Visual Basic Editor. Click again and you're back to Excel. The three windows in the Visual Basic Editor If you want someone to work, open your e-mail program and send them a message in a language
they understand (English, Spanish, French). If you want Excel to do some work for you, open the Visual Basic Editor and write the instructions in a language that Excel understands with Visual Basic for Application (VBA). You develop, test, and modify macros (VBA) procedures in the Excel
Visual Basic Editor (VBE). The VBA procedures are developed in the Excel Visual Basic Editor and become part of the workbook in which they are developed, and when the workbook is saved, the VBA components (macros, modules, user forms, and so on) are stored at the same time.
When you send the workbook to the recycling bin, the VBA procedures are gone. If you are working with the VBE, you should always see 3 windows. The (1), the(2) and the(3) as below. The 3 windows may not appear on the screen. We're going to fix it now and it can be a little bit difficult.
But once you put them, they will always stay in their position. When a window is open under the toolbars, close it. In the vBE menu bar, select View and Properties window. The window may appear minimized, it can be full width at the top of the screen or many other options. You want it
from top to bottom on the right side of the screen. To do this, click on the blue line at the top, hold it, and drag it to the lower-right corner. It is now minimized. Click again on the blue header, hold and drag it completely to the left (it will even disappear) towards the vertical center of the screen.
It is now located in the following position: Go back to the menu bar and select Project Explorer. From wherever it clicks on its blue header, hold and drag it all the way down in the lower right corner. It's now free. Reduce the size of the Project Explorer to approximately the width of the and
one-third of the height by using the double arrows that appear when you move the mouse over the frame of Project Explorer. Click the blue header again, hold the upper-left corner of Project Explorer over the upper-left corner of the Properties window and bring it. Then let go. You now have
the Project Explorer in the left part via the properties windows Screen. The code window appears when you double-click a sheet name in Project Explorer. Later, the code window also appears when you double-click a user name or module name. You can resize the 3 windows by moving
the cursor over the borders (*) and dragging them to the right, left, up, or down. You can use ALT/F11 to navigate from Excel to vBE and back. Recording Your First Macro Microsoft Excel has a built-in macro recorder that translates your actions into VBA macro commands. After you record
the macro, you can see the layout and syntax. Before you record or write a macro, plan the steps and commands that you want the macro to perform. Any action you perform while recording the macro is recorded, including the correction you made. In this example, we record a macro that
sets the cell background color to light yellow. To record the macro, follow these steps: 1. Select New Macro Recording under Tools Macro 2. In the Include Macro dialog box, type SetBackgroundColor in the MacroName text box to set the macro name. Leave all other options by default, and
then click the Ok button. This will start the macro recording. 3. In the background color area, select the Light Yellow box. This action sets the background of the current cell (A1) in light yellow color. 4. To stop the macro recording, click the Stop button (the navy blue rectangle) on the Macro
Recorder toolbar. Now you have recorded a macro that sets the cell background to light yellow. See Recorded Syntax The recorded macro is ready for use. Before we run the marco, let's look at the syntax. 1. To load the Visual Basic Editor, press [Alt] and [F11] at the same time.
(Remember our previous lesson?) The Visual Basic Editor appears. 2. Expand the Modules folder in Project Explorer by clicking the plus sign (+). 3. Double-click the Module1 folder to view the subroutine (marco). As the illustration shows, the name of the subroutine is SetBackgroundColor.
The color index for the light yellow is 36. The background pattern is solid. Run the recorded macro In our previous example, we created the Hello World! macro. We ran the macro in the Visual Basic editor. This time, we'll run the recorded macro on the worksheet. 1. On each worksheet,
select from D3 to E6. 2. Run the recorded macro by extrasing macros or pressing [Alt] and [F8] at the same time. 3. The Macro dialog box is Because there is only one macro in the module, the only macro, SetBackgroundColor, is selected by default. Click the Run button to run the macro. 4.
Cells D3 to E6 now have a light yellow background color. Let's Lea rn some basi cs for e wr itVBA Code: Range Object and Cells Property Range represents a cell, a row, a column, a cells that contain one or more contiguous cell blocks or a 3D range. We'll show you some examples of how
range objects can be used. The following example places the TEXT AB on Sheet2 in the A1:B5 range. Worksheets (Sheet2). Range(A1:B5) = AB : Note that Worksheets.Range(A1, B5) = AB returns the same result as the above example. The following position AAA on cell A1, A3 and A5
on Sheet2.Worksheets(Sheet2). Range(A1, A3, A5) = AAA Range object has a Cells property. This property is used in all VBA projects (very important). The Cells property accepts one or two indexes as parameters. Example: Cells(index) or Cells(row,column), where row is the row index
and column is the column index. The following three statements are interchangeable: ActiveSheet.Range.Cells(1,1) Range.Cells(1,1) Cells(1,1) The following result returns the same result: Range(A1) = 123 and Cells(1,1) = 123 The following sets XYZ to Cells(1 Accepting 12) or Range(L1)
Cell A1 is the current cell: Cells(12) = XYZ The following sets XYZ to cell C3: range(B1:F5).cells(12) = XYZ * The small gray number on each of the cells is for reference only. They are used to show how the cells within the range are indexed. Practice a simple VBA program There are two
ways you can program a VBA 1. To write Visual Basic functions to the VB editor. In this subsection, we'll show you how to create your first macro (VBA program). We will be the world classic Hello World! for example. To create the example, please follow these steps: 1. Open the Visual
Basic Editor by going to Tools Macro Visual Basic Editor or simply pressing the [Alt] and [F11] keys at the same time. 2. From the Insert menu at the top of the Visual Basic Editor module, select to open the module window (code window). 3. In the module window, type Sub showMessage()
MsgBox Hello World! End Sub 4. Click the Run button, press [F5], or go to Sub/UserForm to run the program. 5. The message box appears with the Hello World! greeting. 2. To place a command button on the spreadsheet and start programming by clicking the command button. To place a
command button in the spreadsheet, you must click View on the MS Excel menu bar, then click the toolbar, and finally select the control toolbox after which the Control Toolbox bar appears. Then click the Buttton command and draw it on the table. Next, click the command button and the
Visual Basic editor will appear. Then the statement as shown in the illustration. The first statement fills cell A1 through cell A10 with the expression Visual Basic, while the second statement adds the value in cell A11 and cell B11, and then displays the sum in cell C11. It's so simple. The
output: Working with variables in Excel VBA The concept of Variables are like mailboxes in the mail. The contents of the variables change from time to time, just like the mailboxes. In VBA, variables are ranges that are reserved for data by the computer store. Like the mailboxes, each
variable must be named. To name a variable in VBA, you must follow a set of rules as follows: a) Variable names The following are the rules when naming the variable in VBA It must be less than 255 characters No distance is allowed It must not begin with a number of period not allowed
Examples of valid and invalid variable names are displayed in table. Valid name Invalid name My_Car ThisYear 1NewBoy Long_Name_Can_beUSE He&amp;HisFather *&amp; is not acceptable Group88 Student ID * Distance not allowed b) Declaring variables in VBA, you must declare the
variables before using them by assigning names and data types. There are many VBA data types that can be roughly divided into two types, namely numeric data types and non-numeric data types (i) Numeric data types Numeric data types are data types that consist of numbers that can
be mathematically calculated with different standard operators such as Add, Minus, Multiply, Parts, and so on. In VBA, the numeric data is divided into 7 types, which are summarized in table. Type memory range of values 1 byte 0 to 255 integer 2 bytes -32,768 to 32,767 Long 4 bytes -



2,147,483,648 to 2,147,483.64 8 Single 4 bytes -3.402823E+38 to -1.401298E-45 for negative values 1.401298E-45 to 3.402823E+38 for positive values. Double 8 bytes -1.79769313486232e+308 to -4.94065645841247E-324 for negative values 4.94065645841247E-324 to
1.79769313486232e+308 for positive values. Currency 8 bytes -922,337,203,685,477,5808 to 922,337,203,685,477,5807 Decimal 12 bytes +/- 79,228,162.5 14,264,337,593,543,950,335 if no decimal number is used +/- 7.9228162514264337593543950335 (28 decimal places). Numeric
data types ii) Nonnumeric data types The non-numeric data types are summarized in table. Data Type Storage Range td&gt; String(fixed length) Length of string 1 to 65,400 characters string (variable length) length + 10 bytes 0 to 2 billion characters date 8 bytes 1. January, December 100
to December 31, 9999 Boolean 2 Bytes True or False Object 4 bytes Each embedded object Variant(numeric) 16 bytes Each value as large as Double Variant(text) Length+22 bytes Same as variable-length string Table: Nonnumeric Data Types You can declare the variables implicitly or
explicitly. For example.B means that the variable sum is implicitly declared and ready to receive the input in the Text1 text box. Other examples of implicit declaration are volume=8 and label='±Welcome'±. On the other hand, for the explicit declaration, usually declared in the general section
of the code windows with the Dim statement. The format is as follows: Dim Dim as DataType Example 2.1 Dim Password As String Dim yourName As String Dim firstnum As Integer Dim secondnum As Integer Dim total As Integer Dim BirthDay As Date You can also combine it in one line
and separate each variable by a comma as follows: Dim password as string, your name as string, Fortnum as integer. If the data type is not specified, VB automatically declares the variable as Variant. There are two possible formats for the character subsequent declaration, one for the
variable-length string and another for the fixed-length string. Simply use the same format for the variable-length string as Example 2.1 above. However, for the fixed-length string, you must use the format shown below: Dim VariableName as String * n, where n defines the number of
characters that the string can contain. For example, Dim yourName as String * 10 means that yourName cannot contain more than 10 characters. For example, in this example, we declared three types of variables, the string, date, and currency. Private Sub CommandButton1_Click(A2)
Dim YourName As String Dim Birthday As Date Dim Income As Currency YourName = Alex Birthday = 1 April 1980 Income = 1000 Range(A1) = YourName Range(A 2) = BirthDay Range(A3) = Income End Sub The output screen of sample message boxes (MsgBox) in VBA for Excel In
VBA for Excel is the primary tool to interact with the user. You can use it to inform, warn, or ask the user (with a Yes/No message box) if they are sure that a particular critical procedure is running (delete things). The code in VBA for Excel to generate the following basic message box is:
MsgBox Thank you If you want part of your message to lie between quotation marks, you need to double the quotation marks as in: The line of code would be: MsgBox The result is in cell A1 If you do not want to display the address of the cell, but its value as in: The line of code would be:
MsgBox The result is &amp; Range(A1). Value Do not forget the white space after is . Input fields You must declare (create) a variable to get the response to a VbYesNo metric field or input field. For the input field you write: varAnswer = InputBox(For how many years?, duration) and for the
message box write varAnswer = MsgBox(Do you want to continue?, vbYesNo, Alert) Practice: Message Box Yesterday I showed that we can display phrases in a range of cells and also perform arithmetic operations in MS Excel. Today, I'll show you how to display message boxes in an MS
Excel worksheet. A message box typically acts as a dialog box in which users can use the computer it is able to perform certain actions in response to what the user clicks or selects. The format for a message box is as follows: message=MsgBox(Prompt, Style Value,Title) The first
argument, prompt, displays the message in the message box. The style value determines which type of command type is displayed in the message box. . The title argument displays the title of the message board. message is a variable that contains values returned by the MsgBox ( )
function. The values are determined by the type of buttons that users click. It must be declared as an integer data type in the procedure or in the General Declaration section. Some examples of different types of message box The codes are as follows: Private Sub CommandButton1_Click()
MsgBox (Welcome to VBA Programming) End Sub The code for message box with Yes No key: Private Sub CommandButton3_Click() Dim message As integer message = MsgBox(Click Yes to, Proceed No to stop, vbYesNo, Login) When message = 6 then range(A1). Value = You can
continue ActiveWorkbook.Activate ElseIf message = 7 Then ActiveWorkbook.Close End If End If End Sub The code for the message box with Yes Without Cancellation key: Private Sub CommandButton1_Click() Dim message as an integer message = MsgBox(Click Yes to continue, No to
exit, vbYesNoCancel, Login) If message = 6 then range(A1). Value = You can continue ActiveWorkbook.Activate ElseIf message = 7 Then ActiveWorkbook.Close End If End Sub Creating and Managing Declaring Array an Array with Dim Statement An array is a set of sequentially indexed
elements with the same intrinsic data type. Each element of an array has a unique identifying index number. Changes made to one element of an array do not affect the other elements. Before signing values to an array, the array must be created. You can declare the array with the Dim
statement. For example, to declare a one-dimensional array of 5 elements, type: Dim Arr(4) The index of the element of the array starts at 0, unless Option Base 1 is specified in the public area (range outside the subprocedure). If Option Base 1 is specified, the index starts at 1. In the
following example, values are assigned to the array and all values are displayed in a message box: Option Base 1 Sub assignArray( ) Dim Arr(5) Arr(1) = Jan Arr(2) = Feb Arr(3) = Mar Arr(4) = Apr Arr (5) = May Msgbox Arr(1) &amp; - &amp; Arr(2) &amp; - &amp; Arr(3) &amp; - &amp; Arr(4)
&amp; - &amp; Arr(5) End Sub * The number within the array , i.e. Arr(1), is the index. One (1) is the index of the first element in the array. Resize an array with redim statement The ReDim statement is used to enlarge or modify a dynamic array that has already been officially declared. If
you have already declared an array with an element value of 5 .B and have decided to change the number of the element to 6, you can do the following to resize the array: Redim Arr(6) We integrate it unser letztes Beispiel: Option Base 1 Sub assignArray( ) 'Dim Arr(5) Redim Arr(6) Arr(1) =
Jan Arr(2) = Feb Arr(3) = Mar Arr(4) = Apr Arr(5) = May Arr(6) = Jun Msgbox Arr(1) &amp; - &amp; Arr(2) &amp; - &amp; Arr( 3) &amp; - &amp; Arr(4) Arr(4) - &amp; Arr(5) End Sub Note that the Dim Arr(5) statement is commoned out because leaving this original statement in the sub
causes a compilation error. Manage Dynamic Array A word of caution when using the Redim statement to resize an array - A resizing of the array can erase the elements it contains. The following example deletes all values assigned before the array was resized. Only the value assigned to
the array after resizing it is preserved. Option Base 1 Sub assignArray( ) Redim Arr(5) Arr(1) = Jan Arr(2) = Feb Arr(3) = Mar Arr(4) = Apr Arr(5) = May Redim Arr(6) Arr(6) = Jun Msgbox Arr(1) &amp; - &amp; Arr(2) &amp; - &amp; Arr(3) &amp; - &amp; Arr(4) &amp; - &amp; Arr(5) &amp; -
&amp; Arr(6) End Sub By replace the Redim Arr(6) with Redim Preserve Arr(6) , all values remain. Example: Option Base 1 Sub assignArray( ) Redim Arr(5) Arr(1) = Jan Arr(2) = Feb Arr(3) = Mar Arr(4) = Apr Arr(5) = May Redim Preserve Arr(6) Arr(6) = Jun Msgbox Arr(1) &amp; - &amp;
Arr(2) &amp; - &amp; Arr(3) &amp; - &amp; Arr(4) &amp; - &amp; Arr(5) &amp; - &amp; Arr(6) End Sub Create Multi-Dimensional Array An array can also store multidimensional data. To simplify our tutorial, an example of a two-dimensional array is used. Suppose you have data about the
annual sale of a local store in the following table and you want to store the data in a two-dimensional array: Year 2003 Year 2004 CD Sale 1,000 1,500 DVD Sale 1,200 2,000 First, we create the array as follows: Dim Arr(2,2) Then we assign the values to the array. We treat the first
dimension as the year and the second dimension as a product sale: Arr(1,1) = 1000 Arr(1,2) = 1200 Arr(2,1) = 1500 Arr(2,2) = 2000 We now show the values of the array with a message box: Msgbox sale of CD in 2003 is &amp; Arr(1,1) &amp; vbCrLf &amp; sale of CD in 2004 is _ &amp;
Arr(2.1) &amp; vbCrLf &amp; sale of DVD in 2003 is &amp; Arr(1,2) &amp; vbCrLf _&amp; sale of DVD in 2004 is &amp; Arr(2,2) as follows: Option Base 1 Sub multDimArray( ) Dim Arr(2,2) Arr(1,1) = 1000 Arr(1,2) = 1200 Arr(2,1) = 1500 Arr(2,2) = 2000 Msgbox Sale of CD in 2003 is
&amp; Arr(1,1) &amp; vbCrLf &amp; sale of CD in 2004 is _ &amp; Arr(2.1) &amp; vbCrLf &amp; sale of DVD in 2003 is &amp; Arr(1,2) &amp; vbCrLf _&amp; sale of DVD in 2004 is &amp; Arr(2,2) End Sub * vbCrLf stands for VB Carriage Return Line Feed. It sets a return and a new line,
as shown in the message box above. The underscore _ on the back of the first line of the message box means Next to the next line With If .. Then. Else Visual Basic Editor in MS Excel is just as powerful as the standalone visual in the sense that you use the same commands in
programming. You can use .B else to control program flow and display specific outputs based on specific conditions in MS Excel. Here I will demonstrate the concept with an example. IF Then statement The IF-Then is a single condition and executes a single statement or a statement block.
For example, the following statement sets the Variable Status to Adult if the statement is true: If Age &gt;= 18 then Status = Adult Is, you can also use a multiline block in the If statement as follows: If Age &gt;= 18 then Status = Adult Vote = Yes End If Note that in the multiline block case,
End If Statement is required where the single-line case is not. IF Then Else The If Then Else statement is used to define two blocks of conditions - true and false. For example, if Age &gt;=22 Then Drink = Yes Else Drink = No End If Again, note that End If statement is also required in this
case, as there is more than one block of statements. Nested it if It is possible to nest multiple IF functions in an Excel formula. You can nest up to 7 IF functions to create a complex IF THEN ELSE statement. The IF Then ElseIf is used to test additional conditions without using new If Then
statements. For example: If age &gt;= 18 and age &lt; 22 Then Msgbox you can choose ElseIf Age &gt;=22 and Age &lt; 62 Then Msgbox You can drink and choose ElseIf Age &gt;=62 Then Msgbox You are entitled to apply for social security benefit Else Msgbox You can't drink or choose
&lt; Let's take another example: The code Private Sub CommandButton1_Click() Dim mark As Integer Dim grade As String Randomize Timer mark = Int(Rnd * 100) Cells(1) , 1). Value = Mark If Mark &lt; 20 and Mark &gt;= 0 Then grad = F Cells(2, 1). Value = Degree ElseIf select &lt; 30 and
mark &gt;= 20 Then grade = E Cells(2, 1). Value = Degree ElseIf select &lt; 40 And select &gt;= 30 Then grad = D Cells(2, 1). Value = Degree ElseIf &lt; 50 mark and mark &gt;= 40 Then grad = C- Cells(2, 1). Value = Degree ElseIf select &lt; 60 and mark &gt;= 50 Then grad = C Cells(2, 1).
Value = Degree ElseIf select &lt; 70 and mark &gt;= 60 Then grad = C+ Cells(2, 1). Value = Degree ElseIf you select &lt; 80 and mark &gt;= 70 then grad = B Cells(2, 1). Value = Degree ElseIf Mark &lt; = 100 and mark it &gt; -80 then grad = A Cells(2, 1). Value = Grade End If Output :
Select Case End Select Normally, it is sufficient to use the conditional if statement. Then. Otherwise, for multiple options or selectors. However, if there are too many different cases, the If Else structure to be bulky and difficult to debug when problems occur. Fortunately, Visual Basic
provides another way to handle complex multiple-choice cases, that is, the Select Case .. End In short Select Case statement is an alternative to the ElseIf statement. This method is more efficient and readable when encoding the If Then ElseIf ElseIf Select Case End Select structure is as
follows: Select Case-Variable Case Value 1 Statement Case Value 2 Statement Case Value 3 Statement Private Sub CommandButton1_Click() Dim Marker As single Dim Mark as String Marker = Cells(1, 1). Value 'To set the alignment to the middle range (A1:B1). Select With Selection .
HorizontalAlignment = xlCenter End With Select Case Mark Case 0 to 20 grade = F Cells(1, 2) = Grade Case 20 to 29 grade = E Cells(1, 2) = grade Case 30 to 39 grade = D Cells(1, 2) = grade Case 40 to 59 grade = C Cells(1, 2) = grade Case 60 To 79 grade = B Cells(1, 2) grade = Case
80 to 100 grade , 2) = Grade Case Else grade = Error! Cells(1, 2) = grade End Select End Sub The diagram at the bottom left shows the output of this example. Explanation: To set the centered orientation of the cell, we use the following procedure: Range(A1:B1). Select With Selection .
HorizontalAlignment = xlCenter End With We can use the statement case value1 to value 2 to specify the range of values that satisfies the case. You should also include the error where the values you enter are aeum or invalid. If the test mark is between 0 and 100.B, a value a-value a-
range is invalid. In this program, I use Case else to handle the error entries. Another example: Select Case Grade Case Is &gt;= 90 LetterGrade = A Case Is &gt;= 80 LetterGrade = B Case Is &gt;= 70 LetterGrade = C Case Is &gt;= 60 LetterGrade = D Case Else LetterGrade = Sorry End
Loop Select Structures This function facilitates repetitive work. For Next Use For Next loop, if the number of loops is already defined and known. A For Next loop uses a counter variable that increases or decreases the value during each iteration of the loop. This loop structure is most
commonly used for our examples on this page. Here is an example of the For Next loop: For i = 1 to 10 Cells(i, 1) = i Next i In this VBA program, place the command button 1 on the spreadsheet and then click it to go to the Visual Basic editor. When you click the button, the VBA program fills
cells (1.1) with a value of 1, Cells(2.1) with a value of 2, Cells (3.1) with a value of 3 through cells (10.1) with a value of 10. The position of each cell in the Excel table is referenced with cells(i,j), where i represents row and j column. Note that by default, the i counter variable is increased by
1. For Next Loop With Step, you can use the Step keyword to sepcize another increment for the counter variable. Example: For i = 1 to 10 Steps 2 Cells(i,1) = i Next i This looping process prints values with an increment of 2 in row 1, 3, 5, 7, and 9 on column 1. You can also in the loop by
assigning a negative value after the Step keyword. For example: For i = 10 to 1 step -2 cells(i,1) = i Next i This looping process is Values with an increment of -2 start at 10 in row 10, 8, 6, 4 and 2 on column 1. DO LOOP In the previous chapter you learned the For .. Next loop to perform a
repeating process. In chapter t, you'll learn more about another looping method known as the Do loop. There are four ways you can use the Do Loop as a show below. COMiP) UDoT.E.. Re.. DULoCoApTWIOhNile (ii) Do until . Loop (iii) Do while Loop (iv) Do Loop until Example 1 Example
2 Examle 3 Private Sub Private Sub CommandButton1_Click() CommandButton1_Click() CommandButton1_Click() Dim counter As Integer Dim counter As Integer Dim counter , sum As Integer Do Do Until counter = 10 'To set the alignment to center counter = counter + 1 counter = 1
Select Cells(counter, 1) = counter Cells(counter) , 1) = 11 - With Selection Loop While counter &lt; 10 counter . HorizontalAlignment = Loop xlCenter End Sub End In this example, the End Sub program continues to add 1 to the preceding counter values because in this example the cells(1,
2) = Y remain less than 10 on Cells(1, 3) = X+Y as long as the counter value is programmed. It shows 1 in addition 1 to the previous cells (1,1), 2 in cells(2,1). Counter value until the Do-While counter is &lt; 10 to 10 in cells (10.1).                 Counter value reaches counter = counter + 1 10. It
shows 10 in Cells(counter + 1, 1) = counter cells(1,1), 9 in cells(2,1)- Cells(counter + 1, 2) = counter .. to 1 in cells (10.1).    * 2 sum = cells (counter + 1, 1) + cells (counter + 1, 2) cells (counter + 1, 3) = sum End Sub In this example, the program displays the values of X in cells(1.1) for
cells(11.1). The value of Y is X2 and the values are displayed in column 2, i.e. from cells (2.1) to cells (2,11). Finally, the values of X+Y are displayed in column 3, i.e. from cells (3.1) to cells (3,11). And it happens when the state never gets wrong. In this case, you can stop the loop by
pressing [ESC] or [CTRL] + [BREAK]. Font and background color Now we'll explore how to create VBA that can format the color of an MS Excel spreadsheet. Visual Basic codes make it easy to change the font color and background color of each cell. All right, I'm going to create a program
that can create random fonts and background colors with a randomize process. Colors can be assigned using a number of methods in VBA, but it is easier to use the RGB function. The RGB function has three numbers that correspond to the red, green, and blue components. The range of
values of the three numbers is between 0 and 255. A mixture of the three primary colors produces different colors. The format for setting the font color is cells(i,j). Font.Color=RGB(x,y,x), where x ,y , z can be any number between 1 and 255 for example, cells(1,1).
Font.Color=RGB(255,255,0) changes the font color to yellow The format to set the background color of the cell is cells(i,j). Interior.Color=RGB(x,y,x), where x ,y , z can be any number between 1 and 255 In the following example, the font color changes to cells (1,1) and the background color
in cells(2,1) for each click of the command button due to the randomized process. Private Sub CommandButton1_Click() Explanation: Randomize Timer Dim i, j, k As Integer i = Int(255 * Rnd) + 1 j = Int(255 * Rnd) + 1 k = Int(255 * Rnd) + 1 Cells(1, 1). Font.Color = RGB(i, j, k) Rnd is a
random number between 0 and 1 255* Rnd generates a number between 0 and 255 int(255*Rnd) generates integers that take the values from 0 to 254. Example; Rnd=0.229 cells(2, 1). Interior.Color = 255*Rnd=58.395 RGB(j, k, i) End Sub Int(58.395)=58 ModulesandProcedures A
procedure is defined as a named set of statements that run as a unit. A statement is simply 1 full line of code. VBA procedures are used to perform tasks such as controlling the Excel environment, communicating with databases, calculating equations, analyzing data... Etc. VBA has two
types of procedures: subprocedures and functional procedures. Subprocedures are written when you want to command Excel such as creating a chart, analyzing data, coloring cells, copying and pasting data, and so on. Function Procedures are created when you to create your own custom
worksheet functions or perform a calculation that is used over and over again. Note that subprocedures can also perform calculations. Modules and procedures and their Scope-A module are a container for procedures, as shown in our previous examples. A procedure is a unit of code that
is enclosed either between the Sub and End Sub statements or between the Function and End Function statements. The following sub-procedure (or subroutine) prints the current date and time on cell C1: Sub ShowTime() Range(C1) = Now() End Sub The following function sums two
numbers: Function sumNo(x, y) sumNo = x + y End function A Procedure: A Function: Excel VBA Procedures-Functions The Concept of Functions A VBA procedure is a block of code that performs. We actually learned something about VBA procedures in our previous chapters, but they are
all event procedures. Event procedures are VBA programs associated with VBA objects, such as.B. command buttons, check boxes, and radio buttons. However, we can also create procedures that are independent of the event procedures. They are typically included in the event
procedures to perform specific tasks. There are two types of above procedures, namely functions and sub-procedures. In this chapter we will discuss functions. We will deal with the sub-procedures in the next chapter. Function types There are two types of Excel VBA functions; one is the
built-in functions, while the other is the custom functions. We can use built-in features in Excel for automatic calculations. Some of the built-in Excel VBA functions are Sum, Average, Min (to find the minimum value in a range), Max (to find the maximum value in a range), Mode, Median, and
more. However, built-in functions can only perform some basic calculations, and more complex calculations often require custom functions. Custom functions are procedures that are created independently of the event procedures. A function can receive arguments passed to it by the event
procedure, and then return a value in the function name. It is usually used to perform certain calculations. Writing function code VBA function begins with a Function statement and ends with an End Function statement. The program structure of a function is as follows: Function
FunctionName (arguments) As the DataType end function in Excel VBA, the End Function statement is automatically displayed when the Function statement is entered. In the Visual Basic Editor window, insert a module by clicking in the click Insert, and then click Module, as shown in the
illustration. In the module environment, button in function code for the function Area_Rect , as shown in the diagram below. Now you can return to the Excel spreadsheet and enter the function in any cell. This example enters the function in cell C1 and displays the width and height values
cell A1 or cell B1. Note that the value of the area is automatically calculated and displayed in cell C1. The formula can be copied and updated to other cells by using the Autofill method, that is, by dragging the placeholder in the lower-right corner of the cell, as shown in the figure below. Few
examples: Methods usually perform something or perform certain operations. ClearContents is, for example.B a method of the Range object. It deletes the contents of a cell or range of cells. You can write the following code to delete the content: Private Sub CommandButton1_Click()
Range(A1:A6). ClearContents End Sub You can also show the user how to select his own range of cells and delete the content using the InputBox function, as shown in the example Private Sub CommandButton1_Click() Dim, selectedRng As String selectedRng = InputBox(Enter your
range) range (selectedRng). ClearContents End Sub To delete the contents of the entire worksheet, you can use the following code: Sheet1.Cells.ClearContents But if you want to delete only the formats of an entire worksheet, you can use the following syntax: Sheet1.Cells.ClearFormats
To select a range of cells, you can use the Select method. This method selects a range of cells specified by the Range object. The syntax is Private Sub CommandButton1_Click() Range(A1:A5). Select Stop Sub In this example, the user can specify the range of cells to be seleted. Private
Sub CommandButton1_Click() Dim selectedRng As String selectedRng = InputBox(Enter your range) Range(selectedRng). Select Stop Sub To deselect the selected range, we can use the Clear method. range (Cirj:Cmrn). In this example, we insert two command buttons, the first is to
select the range, and the second is to deselect the selected range. Private sub-CommandButton1_Click() range(A1:A5). Select End Sub Private Sub CommandButton2_Click() Range(A1:A5). If you delete End Sub instead of the Clear method, you can also use the ClearContents method.
Another very useful method is the autofill method. This method autofills the cells in the specified range with a number of elements, including numbers, days of the week, months of the year, and more. The format is Expression.AutoFill(Destination, Type) Where expression can be an object or
a variable that returns and objects. Target is the required range object of the cells to be filled. The destination must contain the source range. Type means serial type, e..B days of the week, month of the year, and more. The AutoFill type constant is something like XlFillWeekdays, XlFillDays,
XlFillMonths and Example Private Sub CommandButton1_Click() Range(A1)=1 Range(A2)=2 Range(A1:A2). AutoFill Destination:=Range(A1:A10) End Sub In this example, the source range is A1 through A2. When the user clicks the command button, the program first fills cell A1 with 1
and cell A2 becomes 2, and then fills the range A1 to A10 with a series of numbers from 1 to 10. Example Private Sub CommandButton1_Click() Cells(1, 1). Value = Monday cells(2, 1). Value = Tuesday range(A1:A2). AutoFill Target:=Range(A1:A10), Type:=XlFillDays End Sub In this
example, the user can select the range of cells to be automatically populated with the Autofill method. This can be achieved with the InputBox. Because each time we want to automatically fill in a new area, we need to delete the contents of the entire worksheet using the
Sheet1.Cells.ClearContents statement. Private Sub CommandButton1_Click() Dim selectedRng As String Sheet1.Cells.ClearContents selectedRng = InputBox(Enter your range) Range(A1) = 1 Range(A2) = 2 Range(A1:A2). AutoFill Destination:=Range(selectedRng) Calling subprocedures
and function procedures There are two ways to call a subprocedure. The following example shows how a subprocedure can be called by other sub-procedures. Sub z(a) MsgBox a End Sub Sub x() Call z(ABC) End Sub Sub y() z ABC End Sub Sub z procedure takes an argument (a) and
displays the argument value (ABC) in a message box. If you run either Sub x or Sub y, the result is the same. The following example sets up a functional procedure from a sub-procedure. The ShowSum subprocedure calls the sumNo function and returns an 8 in a message box. Sub
ShowSum() msgbox sumNo(3.5) End Sub Function sumNo(x, y) sumNo = x + y End function If there are duplicate-named procedures in different modules, you must include a module qualifier before the procedure name when calling the procedure. Workbooks Each object contains its own
methods and properties. A property represents a built-in or custom feature of the object. A method is an action that you perform on an object. The following are examples of a method and a property for the workbook object: Workbooks. Close Closing method close the active workbook
workbooks. Count Property returns the number of workbooks that are currently open Many VBA beginners start their careers with Cells. For example, cells(1,1). Dial ingess is the same as Range(A1). Select and cells(11,31). Select is the same as Range(AE11). Select. It is strongly
recommended that you use range instead of cells to work with cells and groups of cells. It makes your sentences much clearer and you are not forced to remember that column AE is column 31. The only time you use cells is if you want to select all the cells on a worksheet as in: Cells.Select
Select All cells, and then empty all cells from values or formulas that you use: You access a worksheet called Balance with: Sheets(Balance). Select Note that the word leaves is plural and never forget the quotation marks within the bracket You can't select a table that is hidden, so you
need to write: Sheets(Balance). Visible= Visible= Tables (balance). Select Sheets(Balance) if you want to hide the sheet again. Visible= False The name of a sheet cannot contain more than 31 characters and may contain certain special characters such as ? : \ / [ ] . If you do not follow
these rules, your procedure will crash. The following lines of code generate an error message: Sheets(Sheet1). Name= Balance and Introduction to Numbers because there are more than 31 characters including the Sheets(Sheet1) spaces. Name= Balance: Introduction because of the
special character: Sheets(Sheet1 ). Name= because the name cannot be empty You cannot switch directly from one sheet to a cell on another sheet. If the active sheet is z.B. Balance and you don't want to go to cell A1 of a sheet named Results, you can't write Sheets. Area(A1). Select,
you need to do two steps: Sheets(Results). Select Range(A1).) Select We have already seen basics for the Range object. Let's learn only a few features. To select a single cell, write: Range(A1). Select To select a set of contiguous cells, use the colon and write: Range(A1:G5). Select To
select a set of noncontiguous cells, use the comma and write: Range(A1,A5,B4). Select To select a set of noncontiguous cells and a range, use both the colon and the comma: Range (A1,A5,B4:B8). Select Some objects have default properties. The default property of Range is e.B. Value.
The following result results in the same result. Range(A1) = 1 and Range(A1). Value = 1 Here are examples of setting and retrieving a Range property value: The following sets the value of the range A1 or Cells(1.1) as 2005. It actually prints on A1 in 2005. Area(A1). Value = 2005 The
following is given the value from the range A1 or Cells(1,1). X = Range(A1). Value method can be used with or without argument(s). In the following two examples, this behavior is of themostrate. Methods that do not use arguments: Worksheets(Sheet). Column(A:B) AutoFit methods that
use arguments: Worksheets(Sheet1). Range(A1:A10). Sort _ Worksheets(Sheet1). Range(A1) worksheets(Sheet1). Range(A1) is the key (or column) by which to sort. At some point, a method uses more than one argument. For example, the Open method takes 12 arguments for the
Workbook object. To open a password-protected workbook, you must write the following code: , , ,pswd Because this method uses so many arguments, it is easy to place the password argument incorrectly. To solve this potential problem, use named arguments such as the following
example: fileName:=, password:=pswd You can also assign an object to an object variable using the Set statement. For example, Dim myRange as Range Set myRange = Range(A1:A10) Create a financial calculator Excel VBA can be programmed to perform complex financial calculations.
Here we have a financial periodic payment for a loan from the bank. Below is the Excel VBA code for the financial calculator and its output interface. Private Sub CommandButton1_Click() Dim N As Integer Dim p, pmt, rate, I, PVIFA As Double p = Cells(2, 2) rate = Cells(3, 2) N = Cells(4, 2)
* 12 I = (Rate / 100) / 12 PVIFA = 1 / I - 1 / (I * (1 + I) - N) pmt = p / PVIFA Cells(5, 2) = Format(pmt, -#0.00) End Sub The formula for calculating periodic payment is payment=Initial Principal/PVIFA, where PVIFA is known as annuity. The formula for calculating PVIFA is 1/i - 1/i(1+i)n where
n is the number of payments. Typically, you can check a financial table for the value of PVIFA and then calculate the payments manually. The Format function is to change the number of decimal places and the use of the character . Selective summation with VBA In the mapping, we have
created a VBA that can perform selective summation according to a number of conditions. For example.B, you can summarize only the numbers that have reached the sales target, and vice versa. The VBA program I show allows you to summarize brands that are less than 50 (which is
considered to be failed) and brands that are over 50 (which were considered to exist). Here is the program Private Sub CommandButton1_Click() Dim rng As Range, i As Integer Dim mark, sumFail, sumpass As Single sumFail = 0 sumpass = 0 Set rng = Range(A1:A10) For i = 1 to 10 mark
= rng. Cells(i). Value Select Case mark Case Is &lt; 50 sumFail = sumFail + mark Case Is &gt;= 50 sumPass = sumPass + mark End Select Next i MsgBox The sum of Failed marks is &amp; Str(sumFail) &amp; vbCrLf &amp; The sum of Passed marks is &amp; Str(sumPass) End Sub
Explanation: rng is declared as range and we can set it to include certain range of cells, here the range ranges from A1 to A10. Then I used the For. Next loop to scan through the selected range rng. Cells(i). The value reads the value in cells(i) and then passed it to the variable marker. To
do selective supplementation, I used the Select Case statement. End Select Finally displays the results in a Create and use form message box If the message box or input box is no longer sufficient to communicate with the user, you must start developing user forms. The form, or userForm,
is also known as the Graphical User Interface (GUI). The form is used to require values, parameters, and information from the user to feed the VBA procedure. Several basic controls can be added to the user form, which are called
Label,TextBox,ComboBox,ListBox,CheckBox,OptionButton,Frame,CommandButton, SpinButton and Image . You can use all kinds of other find on the Internet, but the problem is that if you send your workbook to other people and the new control is not installed on their computer, it will not
work. Tab Order Once you've added the controls here, an important feature. The user can the mouse to switch from one control to another, but it should also be able to switch from one control to another by typing a value in one and clicking Enter or Tab, and the focus is set to the next
control where you don't want it to enter a value on a label. More importantly, if the user enters a value in the final control, to and use the focus on the right command button (send) and not on another such as Close Form. To ensure that the user moves from one control to the next in a
specified order, you must set the tab order. To do this, right-click the form itself and select the Item Order. Follow the instructions. The first control in the list is the one that is active (blinking cursor in it) when the form is activated. Bring the controls that the user (labels) do not want to use to
the bottom of the list. For the controls that you do not want to use, you can also set the TabStop property of each control in the Properties window to False. Manage controls You can move the controls by clicking them by holding and moving them. You can resize by selecting it and using the
different handles around it. You can copy or cut them by right-clicking them and selecting the correct menu item. After you add your controls, you may want to align some of them or resize some items so that they are all the same size. To do this, you must first select many controls at the
same time. To do this, click the form on the left near one of the controls you want to select. Hold and drag the drawing of a border that contains many controls. When you release the button, all controls that are touched by the border are selected. Right-click on one of the selected controls
and this context menu appears: You can then align the controls (7th menu item) or create them in the same size (8th menu item). User Forms Properties and VBA Code As you saw in Lesson 1 on theVisualBasicEditor, double-click the name of the user form in the Project window and its
properties appear in the Properties window: In the Properties window of the VBE, you MUST change the name of the form, its label (the name in the blue band at the top of the UserForm) and you can also change the default setting of one of the 32 other properties of the form. If you are
using a form always use the prefix frm as in frmDatabase and are as descriptive as possible so that your code is easy to read. Always use one or more uppercase letters in the name. When you write in lowercase, Excel is capitalized with some letters so that you know that the name is
spelled correctly. The label is what your users see at the top of the user form. Be as informative as possible and complete the information with a label if necessary. Apart from name and label, there are only a few properties that you might want to change. You can a different color for the
background with the BackColor property. By default, the user form appears in the center of the screen. If you want it to appear somewhere else, set the Start property to 0-Manual and use the Top and Left properties to set a new location. The code-opening and closing of the user form The
first thing to do is to create code to access your user form. Here's a basic line of code that does this: The line of code to close the user form is: or I'm the common name of the active form The Hide set is usually part of the code of a command button in the form. A user clicks the GO, SEND,
SUBMIT, or CANCEL button, and part of what needs to happen is that the user form disappears from the screen. Labels In the toolbox, the label has this icon . The label is a passive control, which means that the user never really acts on it. It's there to inform the user and label other
controls such as text boxes, combo boxes, or list boxes. Properties The other interesting properties of the label are: - TabStop: To make the control invisible to the Tab and Enter keys (see Tab Order), set this property to False. - WordWrap: If you want to write more than one line of text in a
caption, set this property to True. Code There is not much encoding developed for the labels, although there are 8 events related to the label. For example, there is an event named MouseMove . If you develop code within this event, it runs when the mouse moves over the label. If the code
is: MsgBox Don't Forget, a message box appears when the user hovers over the label. You can stack many labels on top of each other and make their Visible property False. You can then make visible one of the labels of an event that refers to another control. For example.B, when a user
selects a specific value in a combo box, a specific label is displayed. Text boxes In the toolbox, the text box has this icon . The text box is the simplest control that requires an entry from the user. The user enters something in it, and this value can then be used in your VBA procedure.
Typically, you add a caption that adds to the text box. For most controls, including the VBA for Excel text box, there are common properties that allow you to change the font, the color of the font, the color of the background, the the frame type and other design features. The 3 windows in the
Visual Basic Editor display the following properties in the Property window when the text box is selected. Properties The other interesting properties of the text boxes are: - WordWrap, to be able to write more than one line on a button, - ControlTipText, which generates a small comment box
when the user moves the mouse over the control. You can use this property to provide explanations and instructions for the command button, - - and visible are properties that you can programmatically modify to disable or make invisible a command button after a previous selection in
another control of the user form, TabIndex is a property that you can change through the Tab Order function, as shown in the UserForms section. - MaxLength to limit the number of characters entered by the user- value or text that is the text in the text box when the user form is enabled
(e.B. Enter your name) To ask users to submit a password to run specific macros, develop a user form with a text box and a command button. In the text box, you can change the PasswordChar property so that when the user enters the password, no one can read it. Use an asterisk, a
sprout, or other sign in it. Code The most important thing to remember is that a text box is what its name says, that it carries text. So if you want to send a numeric value from a text box to a cell, you must use the value thing: Range( A1 ). Value=tbxInput.Value Command Buttons In the
toolbox, the command button has this icon. The command button is a very active control and there is always VBA code behind it. The command buttons are typically placed at the bottom of the form and are used to complete the transaction for which the form was created. The label of these
buttons are usually Go , Run , Submit Cancel , etc. Properties The other interesting properties of the command button are: - WordWrap, to be able to write more than one line to a button, - ControlTipText, which generates a small comment box when the user moves the mouse over the
control. You can use this property to give explanations and instructions about the command button, For advanced users, there are the: - Enabled and Visible Properties, which you can programmatically modify to disable or make invisible a command button after a previous selection in
another control of the user form. Code Name your command button before you develop your code. VBA uses the name of the command button when creating lines of code related to events. So if you don't name your command button, VBA creates the private sub:: Private Sub
CommandButton1_Click(), as if you call the button cmbSubmit, e.B. the private sub starts with: Private Sub cmbSubmit_Click() If you name your command buttons after private subs have been created, they will no longer work. A very simple VBA procedure for the command button look like
this: Private Sub cmbSubmit_Click() Sheets(Code). Range(F1). Value = cbxInput.Value End Sub The contents of the cbxInput combo box are entered in cell F1 of the Code sheet and the form (frmPassport) is closed. List boxes Before we start in the list box The difference between a combo
box and a list box is that the combo box is a drop-down list and the user user a single value from the drop-down list. The list box displays a specific number of values with or without a scroll bar, and the user can select one or more values. In the toolbox, the list box of this No programming
icon is required to submit the list of values offered to the user within the combo box. Search for the RowSource property. The RowSource property: The values to be displayed in the combo box drop-down list are transmitted in the RowSource property. For example, if the value of the
RowSource property balance! A1:A12 The values in cell A1 to A12 of the sheet named Balance are offered as a selection to the user who clicks the small arrow of the combo box. The rules for submitting the RowSource property is the name of the sheet in which the list is located, followed
by an exclamation point (!), the address of the first cell, a colon, and the address of the last cell. IMPORTANT: If there is a space or special character in the name of the sheet in which the list is located, you must surround it with single quotation marks like in 'New Balance'! A1:A12. Combo
Boxes Before we start on the combo box The difference between a combo field and Alistboxis is that the combo box is a drop-down list and the user can submit a single value from the drop-down list. The list box displays a specific number of values with or without a scroll bar, and the user
can select one or more values. If you're looking for a drop-down list (also called pull-down lists) that you can use in a regular worksheet, you'll see the much simpler and more user-friendly Excel drpdwnlistsin on the Excel website. When you double-click the combo box in the VisualBasic
Editor, all properties are displayed in the Properties window. No programming is required to submit the list of values offered to the user in the combo box. Search for the RowSource property. The RowSource property: The values to be displayed in the combo box drop-down list are



transmitted in the RowSource property. For example, if the value of the RowSource property balance! A1:A12 The values in cell A1 to A12 of the sheet named Balance are offered as a selection to the user who clicks the small arrow of the combo box. The rules for submitting the RowSource
property is the name of the sheet in which the list is located, followed by an exclamation point (!), the address of the first cell, a colon, and the address of the last cell. IMPORTANT: If there is a space or special character in the name of the sheet in which the you must surround it with simple
quotation marks as in 'New Balance'! A1:A12. Option buttons, check boxes, and borders In the toolbox, the option button has this icon, the check box has this, and, the border of this. You don't need to add a label to accompany the check box or option button because they come with your
own. The check boxes and the radio buttons are both User a choice. The main difference between check boxes and radio buttons is that if a user has 5 of each form, they can select all 5 check boxes, but can select only one of the radio buttons. If you want to create two sets of radio buttons
that are read at the bottom of frames and radio buttons. If you do not want to use frames to create groups of radio buttons, you must use the GroupName property of the radio buttons. All radio buttons with the same GroupName work together. Properties - WordWrap to write more than one
line to the caption, - ControlTipText, which generates a small comment box when the user moves the mouse over the control. You can use this property to provide explanations and instructions about the option button or the check box. - Properties that you can programmatically change to
disable or make an option button or check box invisible after a previous selection in another control of the user form are enabled and visible. Frames frames are also passive control. Frames are used to improve the layout of the user form. You can use them around a group of controls that
have something in common. Frames are becoming increasingly important for managing radio buttons. If you have two sets of radio buttons in a user form and you don't place them within a frame, they all work together, and you can select only one. If you set each set within a frame, you can
select one in each set. When you move a border, it moves all of its controls. Advance Form controls Spin Button In the toolbox, the rotary button has this icon. You can ask a user to enter a value directly into a text box, but you can make things a little more imaginative by using a text box
and a rotary button. The spin button is not really used by itself. Because the spin button does not display its value, it is usually used with a text box. The text box displays a number, and clicking the arrows of the rotary button increases the value in the text box by 1 or 5 or 10 by the value set
within the properties of the knob. Features The other interesting features of the spin buttons are: - Min is the minimum value of the rotary button. It can be negative - Max is the minimum value of the rotation key. It can be negative - Small is the value of the change when the user clicks the
arrows - Large is the value of the change when the user clicks the scroll bar of the rotation key Image Control There is Control in the toolbox named Image . Within this control, you can view all kinds of images. You set an image control for a user form and send an image in the Picture
property. The image becomes part of the control and user shape. Adjust the image The first thing you want to do is fit the image into the image control so that the control resizes to fit the size of the image. If you in the Visual Basic Editor and click an image control that appears a frame with 8
carry around it (picture below). If you end up stretchy on the middle wear (if a two-headed arrow is displayed) on the right side or on the middle one at the bottom or bottom right corner, the image control adjusts to the image size. Double-clicking elsewhere takes you to the VBA code and
does not adjust the control size to fit the image size. PictureSizeMode property Another interesting property of the image control is pictureSizeMode. If the property is set to the default value of 0-frmPictureSizeModeClip, the control size can be changed without changing the image size. So
you can only see part of the image or there can be a background behind which color you can change at will. If the property is set to 1-frmPictureSizeModeStretch, the image resizes the same as the control. The image fills the control. If the property is set to 3-frmPictureModeZoom, the
image resizes like the control, but the image and background are present. Event Handling When does the VBA procedure (macro) begin? When an EVENT takes place. The event triggers the VBA Excel procedure. Clicking on a text box on the worksheet 95% of the VBA procedures you
developed are triggered by clicking a button on a worksheet. I prefer to use text boxes instead of VBA command buttons because they are much easier to maintain and allow much more creativity in design. You can use the font and background color you want. If you're a little creative, you
can add 3D effects, special boundaries, and the like. A few notes on Excel text boxes: I always keep the Excel drawing toolbar visible at the bottom of my screen you create text boxes by left-clicking the icon, let the button go, then go to the worksheet left click, hold and stretch the text box.
If the border of the active text box consists of diagonal lines, you can use the text within the text box. When you click the border again, it becomes a set of dots, and you can then use the text box itself. Right-click the margin in one of the two states and you'll see that the menus are different.
First, you develop a macro in a module in the VBE. Then click the text box and when the border becomes a set of dots, right-click it and select Assign Macro. Select a macro from the list that offered. A simple macro to call a user form would look like this: Sub proUserFormWeighing() End
Sub You can assign a VBA macro to a text box and also to a WordArt, an image, or another shape from the Drawing toolbar. After a macro or hyperlink is assigned to a button (picture, word image, or text box), you must right-click it to change it. Download one of these buttons (click on it in
your browser on the right and select Image as ). Save it to your desktop: Insert the image you imported on the first sheet Insert/Picture/Off File/Desktop/.gif . After the image is added to the sheet, right-click the image, select Assign Macro, and select a macro from the list. Click OK . Now
click on the picture. You can borrow all kinds of buttons from the Internet or create your own from the Design toolbar and use them as triggers for your VBA procedures. In the Excel menu in Excel, you can run an Excel VBA macro by clicking the Tool/Macro/Macros menu. then select the
macro from the list and click Run. Open many workbooks with macros in them. When you go to the Tool/Macro/Macros menu. You will notice that you have access to all macros from all open workbooks. This means that you can save ALL useful Excel macros to a single workbook (call it)
and have access to them while the workbook opens. For example, suppose you have designed a macro that multiplies the contents of a cell by 2. When open, you can call this Excel macro from any cell in another workbook that is open. No need to copy your essential macros into all your
workbooks, just open them and get them to work. When you click a key on your keyboard first, you need to program a key. To do this, go to Tool/Macro/Macros. and then select a macro from the list. Click Options and follow the instructions. Assign your macros to uppercase letters (e.B.
Shift/A instead of Shift/a) to ensure that you don't use any of the many lowercase letters that Excel already uses. You can also assign a macro to a key when you use the ExcelMacro recorder. Debugging and handling errors After you write a macro and VBE has helped you correct most
errors after you test your macro, error messages may still be generated, and you or the user will see this window: This window is not a problem if you or close colleagues are the only users of the workbook. But in other rare cases where you distribute your workbooks to many users, you'll
probably prefer a more useful error message. Here is the basic way to handle errors. A VBA procedure is typically run from sub to end sub. In a VBA procedure that contains an error handler, it runs from sub to exit sub, but if an error occurs during execution, it jumps to a special address
where it is error handler. To add error-handling functions to one of your VBA procedures, do the following: 1- Add an Exit Sub directly before End Sub 2 - Between these two lines, add an address that ends with a colon (addJump: for example) 3- Make room between the address line and
End Sub to enter your code that handles the error. 4- At the beginning of your code enter On Error GoTo addJump 5- As in the example below, the error handler can be a message box Your coordinates to the user: MsgBox An error has occurred, call Peter at 1 613-749-4695 Example 1:
Sub proTestErrorHandler() On Error GoTo addJump xxxxxx Exit Sub addJump: MsgBox An error has occurred, call Peter at 1 613-749-4695 End Sub/Paste the examples in a separate module and run them. Since the workbook xxxxxx cannot be found, a message box appears to indicate
an error, call Peter at 1 613-749-4695. VBA macros Security and Protection in Excel Special Note for Excel 2010 users: Learn how to install yourOfficeCD's Visual Basic Editor and set the security level of your Excel. Sometimes you send a workbook with macros to a colleague. If he can't
get them to work, it's probably because his security setting is high. Just tell him how to change his level by going to the Tools/Macros/Security menu bar and following the instruction. Each time you open a workbook that contains macros, the following dialog box appears. Adopt the same
setting as you have with documents attached to emails. If you know the origin of the file, you can enable the macros if you don't click Disable Macros and you're fully protected. You can view the workbook, but the VBA procedures (macros) are not operational. You can go to the Visual Basic
Editor to catch a look at the macros. If nothing looks suspicious, close the workbook and reopen it to enable the macros. Password Protection of code As an Excel VBA developer, you may want to protect your code so that no one can change it. In the VBE Editor, go to Tools/VBAProject
Properties/Protection . Select the check box and send a password. Make sure you save the password somewhere you'll remember, because cracking Excel VBA passwords is expensive. Form controls and ActiveX controls. The Forms controls are not very complicated, and they have been
part of Excel for some time. Both can be linked to cells and ranges on the worksheet. Some advanced users have attributed erroneous behavior to the ActiveX controls from the Controls Toolbox. There are external similarities, usually in appearance, between Excel Forms controls and
ActiveX controls. The ActiveX controls are similar to the ActiveX controls that are available in VBA for use in UserForms. In Classic Excel and VBA, Forms and ActiveX controls are available on toolbars, while in Excel 2010 they are on the Developers tab of the ribbon Were. Forms Controls
ActiveX Controls VBA Controls Forms and ActiveX Controls in Excel 2003 Forms controls can be used in worksheets and chart sheets. Form controls can also be placed in embedded charts in Classic Excel (though not in Excel 2010). ActiveX controls can only be used in worksheets. Excel
responds to a form control after the user has finished interacting with it (that is, clicks). Excel responds to an ActiveX control. If a form slider is associated with the value of a cell, the user must move the bar on the control and then release it before the cell is updated. When an ActiveX
ScrollBar is linked to the value of the cell, the cell is continuously updated when the user moves the bar along the control. In general, I use the Forms controls unless I need the continuous response of an ActiveX scrollbar. Formatting controls forms can be formatted as if they were normal
shapes (Excel 95 through Excel 2003 shapes; the new shapes in Excel 2010 are completely different animals), although the options are not as extensive as shapes and vary for different control types. The button dialog (below) is similar to that for shapes with different fonts, sizes,
orientations, and similar tabs, although the button remains with its gray color and rectangular shape. A regular shape can be assigned a macro in the same way, with all the shape's formatting options. Depending on the control, there is also a tab for properties that are specific to the control.
For a drop-down or list box control, you can select an input panel that contains the list of items that are displayed in the control, and another for a cell link where the selected item is stored in the control. ActiveX controls have a scaled-back format control dialog, but a rich formatting
environment offered by the Properties window. In addition, some controls have properties that specify the addresses for the list fill area and linked cell. Project Assignment: Make a project for a shopping center according to the following requirements: Category Item Electronic S-Tv
Refrigerator Microwave Nanurn Views: Top data should be in Excel sheet that can be changed. The project form should display the items from the sheet. If the user selects electronics from the list box, the next combo box should display the related list of electronic items such as television,
mixer, and so on. The same applies to clothing. If user specifies quantity z.B for Television ID quantity is 4,Amount Text Box should display the amount for 4 TVs. User can select discount, other items then last amount will be amount - discount + cost for other items . This should be
displayed in final amount to be paid. Paid.
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